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About this PDF Guide

Whether you create or receive PDF documents, you want them to be ready for output right away. You want to 
prevent any problem which may disturb the workflow. You can do this by using the PDF/X standards and the PDF 
creation, editing and preflight software.

Even though these software are powerful and sophisticated, errors or inconsistencies may still occur in the PDF 
documents. And of course you want to find and resolve these problems in the blink of an eye. You also want to 
know the cause and the solution of these problems, so that you can prevent them in the future. To this end, you 
will find this Ultimate PDF/X Guide a useful work of reference.

Purpose and structure of this PDF/X Guide

This Ultimate PDF/X Guide aims to help you to apply the PDF/X standards when you are creating or receiving PDF 
documents. When you submit your PDF documents to a preflight check, you will obtain a list of (potential) prob-
lems, presented in a preflight report. The error messages in this preflight report are the starting point for this 
Ultimate PDF/X Guide. All the error messages which may appear in a preflight report are described in this Ultimate 
PDF/X Guide, together with their possible cause(s) and tips how to resolve them. Some detected errors in the PDF 
document are automatically corrected by the profiles available in many of the software solutions presented here. 
In those cases, you will find a description of the problems that have been resolved.

You can easily find a description of a given problem by means of the quick-find lists. These lists present an over-
view of all the errors and cautions, sorted by profile with a reference to the page in this Ultimate PDF/X Guide 
where the problem is described in detail.

You can find these quick-find lists in “Part 5: Description of the Errors and Cautions in the PDF Reports” on 
page 127.
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When you have found the cause of and the solution to a problem, you undoubtedly want to prevent that problem 
in the future. You can easily do so as a PDF document provider, but also as a PDF document recipient: you can 
use the preflight report to discuss problems, if any, with your suppliers. Or you can prevent problems with PDF 
document by using the software products described in this PDF/X Guide. 

The following parts provide background information about the PDF/X-1a standards and deal with the technolo-
gies on which the standards are based:

• “Why PDF/X?” on page 11

• “Part 3: Enfocus Software PDF/X Solutions” on page 65

Online versions

You can also find more information on the PDF/X standards on the IPA Web site:
www.ipa.org/publications/pdfx.php3.

http://www.ipa.org/publications/pdfx.php3
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Preface

Welcome to the Ultimate PDF/X Guide. This guide was produced to address the needs of the publishing industry 
as it begins to embrace the new PDF/X standards. As you will see, there is a lot of information included in this 
book to inform you of what the standards are, how they can be used, and what is required beyond the PDF/X 
standards to achieve a successful print production project. In addition there is a very comprehensive section on 
preflight errors which explains the various problems that can be introduced to PDF/X workflows.

We have also included information on all of the currently available PDF/X software solutions to allow you to see 
the many options that are available as you begin your adoption of PDF/X workflows. As you read through the 
book you may notice that the Enfocus Software section may seem large in comparison to some of the other solu-
tions. While this section may seem comparatively large… they earned it. This book may not have been possible 
without the generous content and production support of Enfocus Software. However, even in this section you 
will find valuable information that will assist you in the successful creation of PDF/X files with ‘non’-Enfocus 
Software solutions.

The sponsoring organizations trust that this book, along with the many other PDF/X resources that are referenced, 
or become available will be valuable tools in your daily production. And while we hope that the information in 
this guide will lead you to success, in no way do the sponsoring organizations endorse any of the products in 
this guide, we only offer them as a representation of the many PDF/X solutions that are currently available.

David L. Zwang
Zwang & Company
4 Marion Street
Danbury, Connecticut 06810
Tel. (203) 743-2275
david@zwang.com

mailto:david@zwang.com
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Why PDF/X?

When people first started looking at using Acrobat and PDF for work in the graphic arts it seemed that everyone 
was blown away by the possibilities of the new format. It had the potential to be so much more robust and 
predictable than PostScript that it was easy to be blind to its real-world shortcomings. Many pundits said, for 
instance, that it was so wonderful that you wouldn't even have to pre-flight PDF files.

Well, we're all a little older, and a little wiser now, and I don't think any of us are quite so likely to grab on to 
the possibilities of a new file format without also asking about the down-side. At the same time, PDF itself is a 
little older, and a much wiser choice for pre-press work than it was way back when people started thinking 
about using it. A lot more functionality for print work has been added over the years.

As graphic arts professionals it's easy to miss one important issue, however, and that is that our industry is only 
a small fish in the PDF and Acrobat pond. Adobe created PDF for the corporate market, not for us. The single 
largest user of Acrobat is the IRS, with a mind-blowing 350 thousand seats of the full Acrobat product. The logic 
for a software vendor like Adobe is obvious - pre-press will never match the potential for Acrobat sales that the 
corporate market can. 

We're therefore fortunate that the requirements of professional graphic arts can be accommodated with some 
relatively small additions beyond those for the corporate sector. 

There are those who would say that we're even more fortunate that a single file format, designed for one 
industry and adapted for a second ends up perfectly positioned to allow the same format to be used for cross 
media publishing. You can design a piece with any software and have it displayed, archived, searched or printed 
just about anywhere …

It's at about this point, of course, that many of you will be scratching your heads and wondering about my 
sanity. 
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Sure, I can make a PDF file and put it on my web site, or e-mail it to my clients for approval, or send it as a digital 
ad for printing in Vogue. Sure, the same file can be viewed on my beautifully calibrated monitor in a dim, gray 
room, as well as on my (uncalibrated) PC at home, and even on my hand-held …

But does it make sense to use exactly the same file in all those places, for all those things?

Of course it doesn't. 

When creating a file for placing on the web I'm likely to spend some considerable time figuring out how to make 
it as small as I can, and how to ensure that it will view well on everyone's computers, even if they've only got 
an old version of Acrobat Reader. Images are likely to be saved in RGB, at least partly to reduce the file size.

When creating a file to be sent as a digital ad to a glossy magazine I want to be sure that the proof I made before 
shipping the file can be as good a prediction of the final printed piece as possible; you can buy an awful lot of 
pre-press time and equipment for the cost of just one bad ad. At the moment, I'll therefore probably want to 
handle my own separation to CMYK so I can tune it for the particular images in the ad, and I may well want to 
do my own trapping too.

Perhaps more importantly, I also want to be very careful to make sure that the publisher will read my file, and 
plate it exactly as I saw it on my proof. 

A document stored on a corporate intranet for viewing by many people throughout an organization may be 
accessed with several versions of viewing applications. The information in the file is typically more important 
than the presentation, so it makes sense for the viewer to do the best it can to display those parts of the file that 
it understands, and not to worry the user too much about those parts it cannot. Thus Acrobat 3 will often display 
a PDF version 1.4 file without any warnings or errors (Acrobat 3 was designed for PDF version 1.2, Acrobat 5 was 
designed for PDF 1.4). Unfortunately, that display may be incorrect - although it still carries most of the infor-
mation, the presentation may be hopelessly wrong.
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But if that makes sense for the corporate sector, it certainly does not make sense in the graphic arts. For the 
pre-press house or printer, the information conveyed by a printed piece has pretty much no value, they are paid 
to make it look right - presentation is everything.

It's perfectly possible to develop a workflow for cross-media publishing that includes a single master for all 
output routes, including web, e-mail, hand-helds and print. That master can be 'purposed' to one version of 
the file for placing on the web, another for print, and others for other delivery mechanisms. Much of the time it 
makes sense to do that “purposing” before transmitting the file to a publisher or printer to minimize the possi-
bility of error, and to maximize your ability to predict and control the look of the final printed piece.

It was exactly this kind of thinking that lead two user organizations involved intimately with digital ad delivery 
to propose that a standard should be developed. Thus DDAP and NAA approached the US standards bodies with 
a request for a standard based on PDF, specifically for data exchange in the print industry. (See below for notes 
on acronyms).

As the body responsible for graphic arts standards in the USA, CGATS agreed with the request, but decided very 
rapidly that such a standard must be designed with the whole of the print industry in mind, not just digital ad 
delivery. After all, the same requirement for a pre-transmission proof being an accurate prediction of the final 
printed piece applies across almost all jobs, as does the high cost of printing something wrong.

And so began the work that led to ISO standard 15930-1:2001, which includes PDF/X-1a.

This is both a file format specification and an application standard. It defines what you can or must include in 
a file; all fonts used in the file must be embedded, for instance. It also defines how a pre-press tool reading the 
file must render it; for example, the embedded fonts must be used rather than fonts previously installed onto a 
RIP. 

A standard like this has many advantages over other commonly used approaches to making job delivery reliable 
and robust. It's an open specification that any vendor can implement without license fees, which means that 
you can use it whatever tools you have for making or pre-flighting PDF files. 
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As a file format it's a strict subset of the baseline PDF specification, which means that any PDF viewer can open 
and display a PDF/X-1a file. Any PDF production workflow can also process PDF/X-1a files, but remember that part 
of the benefit of PDF/X-1a is in ensuring that a file will be rendered in the same way by every system - processing 
a file through a workflow that is not PDF/X-1a compliant runs the risk of output that does not match.

Although only published in December 2001, PDF/X-1a has already been implemented in a number of file conver-
sion and pre-flight tools. Many more are in development, including pre-press workflows tailored explicitly to 
make compliant proofing and output as easy as possible.

In the longer term even wider availability of cheap creation and validation tools, including direct export to 
PDF/X-1a from design applications is likely. Even with the tools available today PDF/X-1a can reduce the cost of 
customer education and increase the proportion of good files that your less sophisticated clients supply to you. 
Instead of supplying Acrobat Distiller job options files, or ground controls for pre-flight tools, just say “send me 
a PDF/X-1a file, prepared for SWOP”. You won't have to fight to work out the best settings in every version of 
every application, and there are many free resources available on the web showing how PDF/X-1a files can be 
created, such as those at www.ddap.org.

Note that comment above - “a PDF/X-1a file, prepared for SWOP”. Just asking for PDF/X-1a is enough to ensure 
that you'll get a file that can be printed reliably, but is not enough to ensure that it will give a high quality result. 

You can think of three layers of requirements. The first is applicable for all jobs in the graphic arts industry - it 
is to ensure that a file can pass through a pre-press installation without errors. The second is to provide a file 
that will print with appropriate quality for a specific industry sector and printing process. For publication printing 
in North America, for instance, that would mean using SWOP, implying a nominal 133 lpi screen, with specified 
ink colors and dot gain, which in turn implies that CT scans should normally be saved at between 200 and 270 
pixels per inch. The third and final layer of requirements is for a specific job or publication and includes trim 
sizes and bleed, the precise resolution to be used for LW scans etc.
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The PDF/X standard is aimed at the first of these layers, applicable to the whole print industry. A number of trade 
organizations and industry associations are considering developing specifications that build on PDF/X-1a that 
would be applicable for their precise market sector, although an individual user could easily develop one as well. 
The third layer of specification can only be supplied by the publisher or designer of a job, in conjunction with 
their printer - nobody else can define the appropriate trim size, for instance. 

Providing a solid foundation for second and third level specifications is a major advantage of PDF/X. The user 
developing such a specification does not need to understand all the internal technicalities of PDF files and 
pre-press processing. As pre-flight tools appear with a single option that allows verification of PDF/X compliance, 
it also becomes easy to test a file against such a specification.

Of course, the print industry does not stand still, and there's increasing interest in evaluating color managed 
workflows as an alternative to supplying jobs pre-separated to the printer. This is especially true for larger 
printers and publishers, where a client may pass on the responsibility for cross-media publishing of a piece 
further down the workflow. 

Color managed workflows are also very relevant for jobs printed on a digital press because there is no established 
color standard like SWOP for such devices - one set of CMYK values can look quite different on different presses. 
That means that I can't prepare a file in CMYK if I care about color accuracy unless I know some details about the 
press it will be run on. If I send a job in sRGB, however, output from a wide variety of presses will probably look 
quite similar.

With this in mind there has been work underway to produce a second standard called PDF/X-3 that will allow 
color managed data to be included in the file. The standard was approved in Spring 2002 and is expected to be 
published later the same year.
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The nuts and bolts of alphabet soup

ANSI - American National Standards Institute. The organization responsible for national standards in the USA.

CGATS - Committee for Graphic Arts Technical Standards. The organization tasked with creating standards for the 
graphic arts industry in the USA by ANSI.

NPES - Association for Suppliers of Printing, Publishing, and Converting Technologies. The organization supports 
and administers CGATS activities, and represents manufacturers, importers and distributors of equipment, 
supplies, systems and software used in every printing, publishing and converting process from design to distri-
bution.

DDAP - Digital Delivery of Advertising for Publication. An association of ad agencies, pre-press companies, 
publishers, printers and their vendors devoted to increasing digital delivery of advertising material for maga-
zines.

ISO - International Standards Organization. One of the bodies responsible for development of international stan-
dards.

NAA - Newspaper Association of America. An association of newspaper publishers and printers and their vendors 
devoted to improving newspaper production in North America.

Martin Bailey
Chairman CGATS SC6 Committee
Senior Technical Consultant
Global Graphics Software
Harlequin - Jaws - MaxWorkFlow

Tel: +44 1223 873800 * Fax: +44 1223 873873
Barrington Hall, Barrington, Cambridge CB2 5RG, UK
martin.bailey@globalgraphics.com
www.globalgraphics.com

http://www.globalgraphics.com
mailto:martin.bailey@globalgraphics.com
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Part 1: A Word From The Sponsor Organizations

Introduction

This Ultimate PDF/X Guide was realized with the sponsorship of some of the major organizations in the prepress 
and graphic industries. In the next few pages, each organization presents its own view on the importance of the 
PDF/X standards.

Topics

This part contains forewords from the following organizations:

• “IPA” on page 18, by the International Prepress Association

• “DDAP Association” on page 20, by the Digital Delivery of Advertising for Publication Association.

• “dMACS” on page 21, by the Digital Magazine Advertising Canadian Specifications.

• “GASAA” on page 23, by the Graphic Arts Services Association of Australia.

• “Time Inc.” on page 24, by Time Inc.
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IPA

The Association of Graphic Solutions Providers

IPA members have historically been on the leading edge of technology 
and have continually focused on developing effective processes and 
workflows to ensure success for their customers and for themselves. In 
the last decade of the 20th century, electronic prepress opened new 
doors of opportunities but also brought with it new problems, including 
the exchange of digital files.

IPA and its members have played a key role in solving these problems. After much trial and error, the industry 
finally settled on TIFF/IT as the most reliable file exchange format for graphic arts applications. It has and will 
continue to serve the industry well because it represents fixed, predictable files, however, it is restricted to raster 
data, which is not practical for smaller advertisers or publications. In addition, raster pages are rather useless 
for archival and cross-media purposes.

PDF has now found its way into professional publishing as a way to distribute files for output production. 
However, PDF alone does not provide the level of reliability required by graphic communication firms. IPA 
members have joined forces with other industry leaders in pursuing the possibilities, which has led to the devel-
opment of PDF/X-1a and PDF/X-3.

These formats address many of the requirements of a print production workflow. They ensure that the PDF file 
has all of the fonts, has no moving images, etc. By design, it also leaves a certain amount of flexibility to allow 
for the differences so each production environment can be addressed individually. 
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Realizing the potential of PDF/X, IPA members are developing workflows that will allow them to leverage files for 
re-purposing and re-publishing in a multi-channel environment. A PDF/X workflow allows them to create and 
process files that will spell success for their companies and for their clients.

IPA believes that supporting this standard initiative is important and we are proud to be able to help bring this 
important resource to the industry.
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DDAP Association

The pressures of business today call for jobs to be available on shorter deadlines, but 
with the levels of quality and accuracy that were expected in the past. By the same 
token, the applications used to create these files have become more complex and, 
with that complexity, more error prone in terms of interpretation and construction. 
In addition to this, both the creators and recipients of these files (agencies and 
publishers in DDAP's eyes) require these files to be used in more media applications 
than just ink on paper.

The only way to achieve these expectations is to put state-of-the-art tools in operators' hands, and that implies 
a state-of-the-art file format. At DDAP, we have always viewed PDF as the file format of the future, but not quite 
ready for prime time. The introduction of PDF/X-1a heralded the arrival of a file format that was structured to 
survive the rigors of a Graphic Arts workflow. Yet deliver the benefits of a smaller file size, a searchable archi-
tecture and a format that can be used in more than one medium.

We believe that adoption of a PDF-based workflow is key to integrating manufacturing and business processes 
and the adoption of a PDF/X-based workflow gives all those advantages PLUS a robust, Graphic Arts-specific file 
format that protects the integrity of creators' intents.

From the Quality House of Graphics standpoint:

All of the above stands, and we are so committed to this file format that our workflow has been re-engineered 
to make PDF/X-1a the digital master from which all our file, proof, plate and film products are derived to satisfy 
our advertising, entertainment and commercial printing clients.

Alan Darling
COO and CTO, Quality House of Graphics.
Chairman, DDAP Association
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dMACS

Everything You Want to Know About PDF/X and Have Been Waiting to 
Ask

The Canadian publishing, prepress and printing community applaud the initiative to 
bring this PDF/X guide to life. 

We are believers in open standards, supporting the recommendations of dMACS 
(Digital Magazine Advertising Canadian Specifications) and SWOP. Our members tell us 
that they are eager to embrace the benefits that well made PDF/X files have to offer.

PDF/X promises to be the building block required to move digital magazine production to the next level, 
providing an open, accredited and universally accepted and supported file format for supplied ads.

Why do we like it? PDF/X is a final digital format which can be vector-based providing a small final file size and 
pre-RIP flexibility. The broad base of PDF file acceptability in the industry make it a superior file format for 
shorter print runs, demanding deadlines and multi-language requirements. And let’s not forget that files can 
be easily repurposed for other output requirements.

PDF/X allows distribution to multiple sites, without the need to remake, consistently every time. As someone once 
said, "You can send it and forget it!".
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But we also know that it is possible to make a "bad" PDF/X file, from a printing perspective. That’s why the PDF/X 
Guide is an important educational and informational tool, providing users with the know-how to get it right, 
every time, so that the promise of the standard can be fully realized.

For information pertaining to dMACS specifications, please visit our Web sites at:

• www.magazinescanada.com/MACS/MACS.shtml

and/or

• www.dMACS.org

www.magazinescanada.com/MACS/MACS.shtml
www.dMACS.org
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GASAA

PDF/X, a Valuable Tool down under…

For graphic arts companies in Australia and the region, international standards such 
as PDF/X are particularly important given the globalization of the industry. 

Our regional industry has dealings with customers and vendors in North America, 
Europe and Asia and the Graphic Arts Services Association of Australia welcomes agreed international production 
protocols such as PDF/X. GASAA, established in 1923, is the regions only pre-press and digital data management 
trade and technical association 

Guidelines for the digital delivery of advertising have operated in Australia for some period now and the emer-
gence of agreed transfer standards such as PDF/X will adds to the predictability of digital data interchange — so 
important in today’s graphic arts industry.

Like our international counterparts, graphic arts companies in Australia are required to handle and output 
production jobs that have been prepared using a myriad of application software with widely varying skills of the 
originator. Adobe’s Acrobat, with its many variables, provides a convenient tool to transfer cross-platform data 
from originator to service providers. PDF/X compliance however should help reduce these variables to acceptable 
levels for consistent pre-press PDF transfer and output.

We look forward to seeing the intent of PDF/X, i.e. a convenient, reliable pre-press and print specific file format 
becoming an industry reality in the near future. GASAA has watched with interest the industry collaboration in 
developing PDF/X protocols and congratulates all those involved.

Garry Knespal
Executive Secretary
Graphic Arts Services Association of Australia
www.gasaa.asn.au

www.gasaa.asn.au
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Time Inc.

The publishing and printing industries are ready for a change. This change is to embrace and to adopt the PDF/X1a 
file format as we have at Time Incorporated. To some, the reasons to change to file format may not be immedi-
ately apparent. Over time, however, you will reap the many benefits that PDF has to offer. With PDF/X1a, I am 
certain that you will soon find ways in improving your workflow both internally and externally. Please keep in 
mind that though PDF/X1a is a professional file format written specifically for the print market, it can also easily 
adapt well to other media. 

Getting started in PDF/X1a is simple. This guide, written for all level of users, from beginners to experts, will start 
you on your way. Whether created in-house or by your pre-press provider, PDF/X1a can be created easily and 
inexpensively. The transition to PDF/X1a may seem troublesome at first, but by adopting a common standard 
(PDF/X1a) of digital file exchange, everyone will benefit. Over time, I am confident that everyone involved in print 
will only exchange files in the PDF/X1a format—you will wonder how you ever got along without it.

Time Inc. has devoted considerable resources to testing and validating the PDF/X1a format. Embracing and using 
PDF/X1a for digital file exchange should be an easy choice for everyone. I hope you are now excited about PDF/X1a; 
it is the file format of choice for print and beyond.

Kin Wah Lam
Director of Digital Development
Time Inc.
1271 Avenue of the Americas, Room 38-03
New York, NY 10020
Phone: 212-522-6580
kinwah_lam@timeinc.com
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Part 2: PDF/X Solutions

Introduction

The PDF/X standards were created by a group of concerned industry leaders in an effort to address many of the 
troublesome issues associated with the increasingly changing, collaborative print publishing process. While it 
would be nice to believe that these standards would solve all of the problems associated with this process, PDF/X 
is just a file format.

The real benefits to this format can only be achieved when created and used in conjunction with specialized 
software that supports and enhances the process itself. Throughout this part you will see many software solu-
tions that have been developed to enhance the needs of your individual production workflows through the use 
of the PDF/X file formats.
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Topics

This part deals with the PDF/X solutions provided by the following companies or organizations:

• “Agfa” on page 27

• “Apago” on page 33

• “callas software” on page 38

• “CGS Publishing Technologies International” on page 44

• “Creo” on page 47

• “DALIM Software” on page 52

• “DDAP Association” on page 56

• “Fujifilm” on page 59

• “Global Graphics Software” on page 61

• “Heidelberg” on page 64
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Agfa

Agfa Apogee Series3 – a new vision of workflow efficiency.

Since its introduction 5 years ago, Agfa Apogee has been expanding the traditional scope of prepress and printing 
by involving designers and content creators upstream by helping them to generate reliable workflow optimized 
PDFs, as well as the pressroom downstream by generating CIP3 PPF files that automatically setup the ink-key 
settings of printing presses. With Apogee Series3, Agfa streamlines workflow even more by automating and 
distributing processes, and by enabling the integration with other departments for enhanced and streamlined 
production. Agfa Apogee also provides support for PDF/X enabling reliable processing of externally created files. 
In short, Agfa Apogee Series3 enables you to move to an all-digital workflow that stretches throughout your 
operation.

How to process PDF/X within Agfa Apogee Series3?

The processing of a PDF/X file in Apogee Series3 is done based on the following steps:

“1. Create an Input Channel for the Apogee Pilot Normalizer based on a hot folder”

“2. Define Preflight options”

“3. Create a Job Ticket”



[ Agfa ]The Ultimate PDF/X Guide

28

1. Create an Input Channel for the Apogee Pilot Normalizer based on a hot folder

Prior to inputting documents, you need to create a PDF/X 
Hot Folder input channel that contains the following:

• a name

• input folder location for the incoming PDF/X files

• output folder location or Page Store where all processed 
files are stored

• input channel properties

• input channel processing options

2. Define Preflight options 

The Apogee Pilot Normalizer generates PDFs from incoming PS or EPS files, and assures that design intent such as 
spot colors, spot blends, multi-tone colors, bleeds, colorized TIFFs, black overprint, and more are reliably 
captured within the PDF file. Once PDFs have been created successfully they can be checked using the built-in 
Enfocus PitStop Server, to assure the PDFs are reliable and will process further downstream as expected. This 
preflight process is also very useful for already created PDFs and PDF/X files that are received from external 
sources. PDFs and PDF/X files that pass the preflight process successfully are stored in a repository that we call 
the Page Store.

You can configure Preflight to generate warnings for specific problems found in the PDF/X files. In this case, the 
PDF/X files are still saved in the Page Store, but they are accompanied by a Preflight report which includes these 
warnings. The Apogee Job Ticket Editor monitors the Page Store, and will detect any such warnings, and will flag 
them in the Available Pages panel. You can also configure Preflight to always fail PDF/X files that do not meet a 
specific set of criteria.
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Preflight is enabled in the PDF/X Hot Folder input channel by selecting 
one of the built-in profiles, or by selecting your own custom profile 
that you created by using the bundled Enfocus PitStop plug-in.

At the same time you can enable the Certify Workflow. The Certify 
Workflow option ensures guaranteed preflighting and document 
consistency. It basically uses the Enfocus Certified technology, and 
enables you to find out who preflighted the PDF, which profile was 
used, and what changes were applied at later stages. All of this infor-
mation is carefully stored within an edit log file and saved within the 
PDF file.



[ Agfa ]The Ultimate PDF/X Guide

30

3. Create a Job Ticket

A job ticket contains the following information: 

• customer information and job description

• available pages/documents in the Page Store

• referenced PDF pages and job pages

• imposition template

• color separations and spot color behavior

• trapping specifications

• output parameters and output device settings
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The job ticket that is being created is referencing 
the PDF/X pages and includes information on how 
the PDF/X is to be processed. Via integrated imposi-
tion, the Apogee system imposes pages and deter-
mines (spot) color behavior. Then the imposed 
pages are passed on to the Apogee PDF RIP (or any 
other PS3 RIP) for rendering.
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One of the major features of Apogee Series3 is automation. 
Therefore, the process as described on the previous pages 
can also be automated by attaching the job ticket to the 
PDF/X Hot Folder input channel. Any file entering this input 
channel, will automatically pick-up the job ticket, and be 
processed according to the descriptions within the job 
ticket without user intervention.

To enhance automation even further, you can also inte-
grate with MIS or other production planning systems using 
JDF. Processing intent is described in JDF upfront, and 
passed along to Apogee by simply dropping the JDF into a 
JDF aware Input Channel. Besides the various process 
specific information does the JDF also include references to 
the PDFs or PDF/X files that are stored within the Page Store. 
As soon as the JDF is received, the pages are picked up, and 
automatically processed within Apogee.
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Apago

Apago PDF/X Checkup is designed to be the most simple tool available for PDF/X verification and creation. Simply 
open an existing PDF file with Adobe Acrobat and click the Checkup toolbar button. Checkup examines all of the 
elements in the PDF file for compliance with the PDF/X standard. When a PDF file fails to comply with the stan-
dard, one click on the “Fix All” button and Checkup automatically fixes the most common errors. The following 
overview demonstrates the use and capabilities of this Acrobat plug-in from Apago, Inc.

Installation

The PDF/X Checkup installer places on the user’s computer: the Checkup plug-in, a user guide in PDF format, a 
job options file for use with Distiller, and a PPD for use with Page Layout programs. The software provides a 
15-day demo period that is fully functional, allowing the user to try the software with live files.

Configuration

PDF/X Checkup settings can be accessed from the Apple menu or from the Results dialog box, which appears after 
checking a PDF file. The Settings dialog box allows the user to select a PDF/X conformance level, a characterized 
printing condition, and whether to use a special PDF/X icon (for Macintosh only) for PDF files that have passed 
PDF/X Checkup’s verification. Starting with version 2.50, Checkup also allows the user to check for common work-
flow concerns, in addition to PDF/X conformance. The optional workflow checks allow the user to screen for JPEG 
compressed images; to accept Type 1 fonts only; to establish upper and lower resolution limits for images; and 
to specify the maximum number of spot colors allowed. Here is a step-by-step guide to setting the configuration 
on a Macintosh.
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1 Start Adobe Acrobat.

2 Select Apago PDF/X-1 Checkup from the About Adobe 
Acrobat Third Party Plug-ins… from the Apple menu.

3 Click Settings.

4 Select your conformance level. Your choices are:

• PDF/X-1a:2001 - The most common conformance level 
designed for blind exchange. All fonts and images must 
be embedded. Colors are limited to CMYK and spot colors.

• PDF/X-3 - Available in Checkup v2.50. PDF/X-3 is a 
superset of PDF/X-1a:2001 that allows managed colors 
including RGB and Lab.

5 Select a Characterized printing condition. A character-
ized printing condition is a printing condition (offset, 
gravure, flexographic, direct, etc.) for which process 
control aims are defined. 

PDF/X Checkup offers a choice of nine different character-
izations that are publicly available via the accredited 
standards process or industry trade associations. “TR 
001”, commonly called SWOP, was created by the 
Committee for Graphic Arts Technologies Standards 
(CGATS) and is commonly used in North America for publi-
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cations. The others are from The Federal Association of German Printers (BVD) and the German Research Associ-
ation for Printing and Reproduction Technology (FOGRA). The BVD/FOGRA characterizations address a wide range 
of printing applications. Visit http://www.color.org/registry2.html for the most up-to-date information on these 
characterizations.

6 Select “Fail if not default” to limit your PDF/X file to the characterized printing condition specified above. Any 
other characterized printing condition will be rejected. If this option is not selected, PDF/X Checkup will pass any 
PDF file that has a valid printing condition whether or not the condition matches the setting for the default 
printing condition.

7 Select “Automatically fix” if you want PDF/X Checkup to change your characterized printing condition to the 
default condition. Please keep in mind that images prepared for one printing condition may not print the way 
you expect if you specify a different characterized printing condition in the PDF/X-1 file.

8 Select “Save using custom PDF/X icon” to use a special PDF/X file icon when saving files from Checkup’s results 
dialog.

9 Select “Workflow Check” to have Checkup examine the PDF file for common workflow problems. 

• Select “Allow JPEG Compression” to allow JPEG compressed images. 

• Select “Type 1 Fonts only” to restrict fonts to PostScript Type 1 fonts only (no TrueType, CID or other non-Type 1 
font ). 

• Selecting “Images must be between...” and filling in the lower and upper dpi limits will generate a workflow 
warning if the resolution of an image is too high or low resolution. 

• Entering a number in the “Allow spot colors” field sets the maximum number of spot colors. To insure CMYK 
only, enter '0'.

http://www.color.org/registry2.html
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Verifying a PDF/X file

The Apago PDF/X Checkup plug-in examines PDF files for compliance with the PDF/X specification. After opening 
a PDF file in Acrobat, you can click the PDF/X Checkup button to check the file for compliance. PDF/X Checkup 
reports whether the file passes or fails and offers the choice to write a report. Here is a step by step method to 
verify a PDF/X file.

1 Open the PDF file in Adobe Acrobat.

2 Click the Checkup toolbar button or Select “Apago PDF/X Checkup” from the Tools menu. PDF/X Checkup quickly 
examines the PDF file and displays a message indicating if the PDF file passed or failed.

A “thumbs up” indicates that the file is a 100% legal PDF/X file and meets all the requirements of the conform-
ance level you selected. You can do one of the following:

• Click Details to view individual the error or warning messages.

• Click Report to generate a tab delimited text file which you can print, import into a database for job tracking 
or send in e-mail to clients and customers.

• Click Save to save the PDF/X file to disk.

• Click Settings to display the Preferences dialog box.
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Fixing non-compliant files

Apago PDF/X Checkup can automatically fix many items that 
prevent a regular PDF file from being a PDF/X file. When 
PDF/X Checkup examines a non-compliant file, a “Thumbs 
Down” will appear. Here you will be offered the option to 
Fix All, view Details, generate a Report, change Settings, 
Save the file or Close:

• Fix All will correct all automatically fixable errors. If the 
file contains errors which PDF/X Checkup can not fix, the 
software will continue to display a thumbs down message. 

• Details... provides detailed information about the PDF 
file examined. The details will be displayed on screen. The 
list will include information about the error and will include 
warnings about features which are not specifically 
addressed in the PDF/X specification.

• Report... Creates a detailed report file.

• Save... Save the PDF/X file to disk.

• Settings... Displays the Preferences dialog.

Pricing and system requirements

PDF/X Checkup is designed to be cost effective as well as easy to use. PDF/X Checkup sells for only $249* per copy, 
A site license is available for $3,000* and company-wide license for $10,000*. Hot-folder automation is available 
as a $100* option. PDF/X Checkup is available for both MacOS and Windows and requires the retail version of 
Acrobat 4 or later. PDF/X Checkup will not work with the free Acrobat Reader.

*Prices subject to change without notice.
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callas software

pdfInspektor2: The Premier Tool for PDF Preflighting and PDF/X Conversion and Verification

pdfInspektor2, released in November 2001, is the first tool worldwide to offer support for the new ISO 15930 stan-
dards PDF/X-1a and PDF/X-3. Furthermore, it offers unsurpassed preflighting capabilities for any regular PDF file.

pdfInspektor2 is available as a plug-in for Adobe Acrobat 4.05 or later on Mac and Windows, from callas soft-
ware's online shop at www.callassoftware.com. It is also available in OEM versions for software developers and 
system integrators: as a shared library on Mac OS, Linux and Sun Solaris or a DLL on Windows, pdfInspektor2 has 
created a lot of interest with companies that need to preflight PDF documents without running Adobe Acrobat. 

Also, for easy integration with existing systems and infrastructure, it is available in combination with the Apache 
Web server, through a special Apache module that makes it possible to implement IP-based access to preflighting 
and PDF/X conversion services.

Introducing callas software

callas software, maker of pdfInspektor2 as well as other PDF tools, such as the Adobe Acrobat plug-ins pdfOutput, 
MadeToPrint and AutoPilot, has been developing PDF-related software and technology since 1997. With its inti-
mate knowledge of today's requirements in editorial and prepress production, callas software has built a large 
customer base throughout the whole world. Many of the largest publishers, agencies, prepress service providers 
and printers rely upon callas software tools on a daily basis. The all-time favorites — besides the Acrobat plug-ins 
mentioned above — are XPress XTensions for printing and automation, as well as the famous FontIncluder for 
embedding fonts into EPS and DCS files.

http://www.callassoftware.com
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After the success of pdfInspektor 1, which was praised 
for its speed, reliability and ease of use, we realized 
that an even more powerful tool for preflighting and 
analyzing PDF was needed, as customers were 
becoming more and more demanding, and the PDF 
format was ever more widely used.

Also, with PDF/X on the horizon, it became clear that 
PDF would quickly become the mainstream format for 
delivery of digital files. Early 1999, we decided to start 
again from scratch, and by today we believe to have 
implemented the most comprehensive and powerful 
PDF analysis engine currently available. 
pdfInspektor2 is based upon PDFengine, callas soft-
ware's own PDF library, which in the meantime has 
been licensed to several of the largest international 
vendors of prepress solutions.

In its current version, pdfInspektor2 offers more than 
400 different checks which can be orchestrated into 
preflight profiles in any combination. While the 
built-in preflight profiles cover more than three 
quarters of most users' daily needs, there are unlim-
ited possibilities to modify the built-in profiles or 
create custom profiles from scratch.

pdfInspektor2 displays the results of its preflight check in the intuitive 
Results dialog box, with powerful navigation features: the user can 
“extract” a problem from the page and display it in the Snap view - an 
extremely useful inspection feature for complex pages where many 
object partially or completely overlap each other.
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When designing pdfInspektor2 we decided to make the technology as open and amenable to integration as 
possible: pdfInspektor2's preflight profiles are stored as XML, the software has various interfaces for automation, 
and it feeds back its results as a report file in either ASCII, PDF or XML format. Also, its comprehensive implemen-
tation of PDF/X conversion and verification has been documented down to the smallest detail so that users are 
not kept in the dark when they wish to learn how pdfInspektor2 is carrying out its PDF/X-related operations.

User-friendly Preflight Reporting

The features most loved by users of pdfInspektor2 are its 
unique ways of displaying results to the user: instead of 
simply providing a dry text-based cumulative summary of 
the errors in a PDF file, it not only provides a hierarchically 
structured display of problem information, but also exten-
sive overview information. 

pdfInspektor2 offers a unique "Snap" feature that displays 
any problematic object on a PDF page in its own window. 

In order to be able to share preflight reports easily with 
colleagues or customers, a highly intuitive and 
self-explanatory "Breakout" report can be created, that 
lists each problem found in a PDF file on its own PDF page, 
accompanied by a detailed description of what that object 
is and what's wrong with it.

“Breakout” is an overview report you can carry home or send to 
your customers. Apart from the Snap-like display of the prob-
lematic objects saved as a PDF file, the accompanying book-
marks provide all the information on the problems as well as the 
source document in general.
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All these features come in handy at a time where PDF/X is 
gaining momentum: Delivery of PDF/X files is requested by 
more and more publishers and printers, with some of the 
largest publishers worldwide, like Time Inc., as fore 
runners. pdfInspektor2 offers a straightforward imple-
mentation of PDF/X, that allows a user to preflight any PDF 
file for suitability for PDF/X and - if all goes well - to turn 
that PDF file into a validated PDF/X file. 

There are also quite a few problems that pdfInsepktor2 can 
fix automatically - e.g. converting LZW compression into 
ZIP compression, setting the Trapped key, adjusting the 
trim box and bleed box, removing transfer curves or trans-
parency: all that's needed to turn an otherwise reasonably 
well created PDF file into an approved PDF/X file. 

If nevertheless there is something pdfInspektor2 cannot 
fix, a detailed problem report will inform the user about 
the errors encountered. Besides this, a user can combine 
the PDF/X specific preflight and conversion with other 
preflight checks that do not form a part of the ISO PDF/X 
standard. Thus, creation and verification of PDF/X files 
becomes a matter of clicking a couple of buttons and 
holding your breath for a couple of seconds.

As XML has become the predominant format for exchanging 
information between applications, the pdfInspektor2 XML report 
will be valuable for those who want to analyze problem reports 
using custom software or who need to store preflight informa-
tion in a database.

Instantly recognizable symbols allow you to ascertain the 
success or failure of the PDF/X verification and conversion process 
at a glance.
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The Company: callas software

callas software gmbh was founded by Olaf Drümmer in 1995 and has become a highly recognized vendor of 
productivity tools for editorial and prepress production. Extensions for the most important mainstream applica-
tions provide impressive potential for increasing efficiency and reliability of day to day tasks like preflighting 
and generation of correct output. Automation tools like AutoPilot help customers streamline mission critical high 
volume workflows. XTensions for QuarkXPress, Quark Publishing System and QuarkDMS, Plug-Ins for Adobe 
Acrobat and Adobe InDesign as well as standalone applications like FontIncluder have become highly valued 
tools for numerous customers worldwide. 

From 1997 on callas software has become one of the most important vendors of PDF tools for prepress production. 
Relying on their own PDFengine has put them in a position where tools with nearly identical functionality can 
be offered as Acrobat plug-ins as well as standalone applications and shared libraries that run on Mac, Windows, 
Linux and Sun Solaris without Adobe Acrobat.

The Founder, Olaf Drümmer

Olaf Drümmer, founder of callas software gmbh, has been involved in the European Color Initiative for several 
years, promoting advanced technologies for tomorrow's media and device independent workflows. Together 
with Stephan Jaeggi and several other industry experts he initiated the Swiss German "PDF Experts roundtable", 
who published the "PDF for prepress White Paper" in 1998. From 1999 on, Olaf Drümmer joined the ISO working 
group for PDF/X and, again together with Stephan Jaeggi, wrote the first draft of the PDF/X-3 standard, which 
has just been approved in April 2002. 

Olaf Drümmer is a frequent speaker at major industry events and offers seminars about PDF for prepress and 
especially PDF/X. His articles can be read in German and Swiss trade magazines, and in 2001, together with 
Thomas Merz, he published the second edition of the "PostScript & PDF Bible". Currently he is focusing on 



[ PDF/X Solutions ] The Ultimate PDF/X Guide

43

advancing color management technology and educational efforts so that color management becomes more 
accessible and viable in day to day production for the average user and will find more wide spread use in the 
hopefully not too far away future.

PDF/X Resources

In Europe, two essential resources have been established that address issues around modern PDF workflows and 
color management, with PDF/X being their natural focus: The Web site of the European Color Initiative 
(www.eci.org) and the PDF/X Web site www.pdfx.info. On these Web sites valuable information - background infor-
mation about PDF/X as well as free cookbook recipes about generation and verification of PDF/X - can be found 
as well as information how to subscribe to various mailing lists, covering areas like implementation of color 
management and PDF/X workflows, as well as a forum for PDF/X developers.

On its own Web site www.callassoftware.com, callas software gmbh offers free demo downloads for most of its 
tools, as well as extensive information about all of its products. The most favorite download in the past months 
has been the White Paper "AutoPilot - Automating PDF workflows". For international customers, a list of 
preferred resellers and integrators of callas software tools and solutions is provided. The callas software Online 
Shop lets customers purchase most products immediately.

Contact:

callas software gmbh
Schönhauser Allee 6/7
10119 Berlin
Germany

Tel +49.30.44390310
Fax +49.30.4416402
E-mail info@callassoftware.com
URL www.callassoftware.com

http://www.eci.org
http://www.pdfx.info
http://www.callassoftware.com
http://www.callassoftware.com
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CGS Publishing Technologies International

Company Background

CGS Publishing Technologies International, GmbH was founded in 1985 in Hainburg, Germany - a small town 
some 30 miles east of Frankfurt. The company comprises a staff of over 50 people based in Hainburg with the 
majority in Research & Development and Technical Support.

CGS became a major supplier of high-end pre-press production and workflow software solutions for the printing 
and publishing industry and, early in 1999, it expanded its overseas marketing by forming CGS Publishing Tech-
nologies International, LLC based in Minneapolis, Minnesota providing sales, marketing and technical support 
throughout the USA.

Product Line

CGS products include:

• O.R.I.S. PageTM, a desktop version of our original full-function pre-press system,

• O.R.I.S. WorksTM, a user-configurable automatic workflow program for file format transformations, OPI, trap-
ping and color management, and

• O.R.I.S. Color TunerTM, a unique color-managed RIP for high-end, contract-quality proofing on ink jet printers. 
Coupled with CGS' own inks and papers to form the O.R.I.S. Digital Proofing System, it is the only SWOP-certified 
drop-on-demand proofing system for ink jet printers. 

All our products support PDF and PDF/X.
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O.R.I.S. Page

Mac and PC users can now use a single program 
to make all corrections and modifications - 
including transparencies and soft edges. The 
O.R.I.S. Page parser is capable of interpreting 
any PDF, PDF/X and PS Level 3 document inde-
pendent of the DTP program used to create the 
pages. All page elements - text, images, 
graphics and paths — are converted to editable 
high-resolution objects and separate layers.

O.R.I.S. Page provides powerful tools for 
retouching, text correction and the creation of 
cut-outs and shadows at an incredible speed 
using OS X in native mode. For maximum 
production reliability finished pages can be 
output in PDF, PDF/X and Flat PS, or in EPS, DCS, 
JPEG, TIFF, TIFF/IT or Scitex Handshake.

O.R.I.S. Page runs on Mac OS X in native mode using the new Aqua user interface as well as on Mac OS 8 and 9 
and Windows 2000/XP.



[ CGS Publishing Technologies International ]The Ultimate PDF/X Guide

46

O.R.I.S. Works

O.R.I.S. Works is a fully user-configurable automated 
workflow solution that uses daisy-chained hot folders to 
define file conversions, color transformations, OPI, trap-
ping and any feature available in O.R.I.S. Page or other 
third-party applications. O.R.I.S. Works can easily be 
tailored to, and configured for, the user's specific require-
ments. As such, it offers a fully automated PDF and PDF/X 
workflow.

O.R.I.S. Digital Proofing System

Comprises O.R.I.S. Color Tuner, CGS inks and Media, and 
any Windows printer to provide SWOP-certified contract 
proofing of PDF and PDF/X files.

O.R.I.S. Color Tuner, based on ICC profiles, provides the 
tools necessary to achieve a true press match using selec-
tive color correction of CMYK and spot colors. CGS inks and 
paper ensure full SWOP color gamut with no color shifting 
over time.

The CGS product line provides an integrated PDF/X editing, 
workflow and contract proofing solution for today's 
pre-media specialist.
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Creo

Committed to PDF/X

The Creo commitment to PDF/X is evident across our entire line of software products, from desktop creative tools 
through to print-production workflow systems. Creo began our strong support of international standards as an 
active member in ISO standards committees and was an early adopter of the TIFF-IT/P1 format. Creo was the first 
company to print a PDF/X-1a file in March, 2000, and our dedication to developing this standard continues today. 
PDF/X is an integral component of a Creo Networked Graphic Production solution, which delivers a fully inte-
grated digital print-production process that extends from idea to delivery. Creo solutions that currently support 
PDF/X are Synapse™ Prepare desktop software, PS/M RIPs, BrisqueTM workflow systems, and the Prinergy® 
PDF-based print-production system. We are proud to participate in this resource book and encourage you to 
incorporate PDF/X into your workflow.

Creo workflow systems and PDF/X-1a

The PDF/X-1a file format improves the reliability of file delivery in PDF by limiting the format to specific usage, 
file types, and color representations, and then by optimizing the file for print-production. Creo currently offers 
four products that support PDF/X-1a creation, verification, and rendering:

1. Synapse Prepare: creating PDF/X-1a from the desktop

Many believed that the introduction of PDF would help to eliminate all of the problems associated with file prep-
aration in the digital workflow. Unfortunately, generating the perfect press-ready PDF file can be a complex 
process. There is ample opportunity for error, which in turn can cause costly time delays in prepress. Creo under-
stands these challenges and developed Synapse Prepare to address them. 
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Synapse Prepare version 1.1 is a Macin-
tosh® desktop application that gener-
ates a secure, tested, production-ready 
PDF with a few simple mouse-clicks. It 
does this from within QuarkXPress™ or 
any other PostScript®-generating 
application by using a “Send2Synapse” 
desktop printer function. Print shops 
and trade shops can create their own 
custom “directives” to specify all print 
and preflight settings associated with a 
job, including those required to 
generate a conforming PDF/X-1a:2001 
file. These directives can be provided to 
the creative teams, which can run 
Synapse Prepare to the exact specifica-
tions of the production facility when 
producing the original files. In doing 
so, Synapse Prepare bridges the gap 
between content creators and print 
professionals, facilitating job integra-
tion and collaboration. Designers using 
the tool can be confident that they will 
produce and submit reliable PDF/X 
output that meets the printer’s specifi-
cations – the first time, every time. 

Figure 1: Synapse Prepare PDF/X-1a:2001 directive
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2. PS/M Macintosh RIP with PDF/X-1a 

capability

With over 5000 systems installed worldwide, PS/M is a 
proven and popular Macintosh-based workflow from 
Creo for RIPing and trapping. It was designed to reduce 
waste and make prepress work more flexible and 
manageable. PS/M version 7.1 features a full suite of 
Plug-ins and Extenders for DTP applications and Adobe 
Acrobat to enhance both creativity and productivity. 
Developed with an intuitive user interface and intended 
for use with filmsetters and small-format platesetters, 
PS/M RIPs PostScript, PDF, and PDF/X1a files to CT/LW 
raster files in a RIP-once workflow. The optional PDF2Go 
module can generate a trapped, raster PDF/X-1a output 
file, enabling users to create PDF/X for electronic distri-
bution and print production.

Figure 2:PS/M PDF2Go produces PDF/X-1a:2001



[ Creo ]The Ultimate PDF/X Guide

50

3. Brisque workflow with PDF2Go

With more than 7000 installations worldwide, Brisque 
systems are the world’s best-selling and most popular 
digital print-production workflow. A recognized tech-
nology leader, Brisque was the first system to produce a 
PDF/X-1a file. In March 2000, Time Inc. used a Brisque 
workflow to publish the first PDF/X in the industry, and 
Brisque continues to be used by other early adopters of 
PDF/X workflows today. The Brisque solution is often 
complemented by another product from Creo – the 
PDF2Go module, which converts RIPed CT/LW pages into 
conforming PDF/X-1a files. This functionality is extended 
in Brisque v4.1, which offers PDF/X-1a file pre-flight 
support.

4. Prinergy PDF-based print-production 

workflow system

The Prinergy workflow is today’s market-leading PDF 
workflow management system. The solution serves the 
widest spectrum of production needs – from short-run, 
high-speed operations, to globally distributed, 
high-volume production. Based on state-of-the-art 

Figure 3: Brisque PDF2Go job ticket template for 
PDF/X-1a output
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technologies and open industry standards like PDF/X, Prinergy solutions organize prepress, plate and film 
production like never before, creating more open, efficient and collaborative environments.

Prinergy was developed to use PDF as its internal file format. The fact that the Prinergy “digital master” PDF is 
already very similar to the standard PDF/X-1a:2001 format made it easy for the system to become PDF/X-1a:2001 
compliant. Prinergy today supports PDF/X-1a file input and processing. With the impending release of Prinergy 
version 2.1, a process plan will be incorporated to allow all imported files to be refined accordingly to PDF/X-1a 
specifications. A single mouse click tells the Prinergy system to include the additional information required to 
create a trapped, resolution-independent PDF/X-1a:2001 file suitable for electronic transmission, digital file 
exchange, proofing and/or plate-making. This feature will provide users the option of working with PDF/X-1a as 
a digital master in Prinergy. Verified and automated PDF/X-1a output capability will be available in the Prinergy 
version 2.1 release.

Committed to open industry standards

A fundamental tenet of the Creo Networked Graphic Production initiative is a commitment to supporting open 
industry technology standards such as PDF/X. Creo Networked Graphic Production solutions are designed to 
streamline production and business processes. They create collaborative environments that provide creative 
professionals and prepress providers with the tools to integrate and optimize print-production systems in order 
that all those involved can achieve the highest levels of quality, efficiency and profitability. The modular, open 
architecture of the solution allows for customization to meet specific business needs and establishes a solid 
foundation to build on as a company grows or changes.

To effectively deploy a Networked Graphic Production environment, all of the systems involved must be able to 
exchange information in a timely and efficient manner. Creo solutions use accepted industry-standard commu-
nication protocols – such as PDF/X-1a:2001 – as the backbone of each product to collect and transfer data across 
the production network and through to the business system. For more information on how Creo is involved with 
PDF/X or to learn more about Networked Graphic Production, please contact your local Creo representative or visit 
www.creo.com.

http://www.creo.com
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DALIM Software

Creating a PDF/X-1a Workflow with DALiM TWIST or SWiNG Applications

DALiM Software’s PDF/X-1a generation tool is one of a collection of pre-defined tools, each tool executing specific 
actions on incoming files. Several tools can be linked together to create a workflow that automates the entire 
production process as required.

The workflow can be something very simple, such as the Normalizer workflow delivered with DALiM Software’s 
SWiNG application, that inputs PostScript/EPS/DCS files, generates a PDF/X- 1a file and stores the file in a local or 
remote directory location.

Example Dalim Software Workflow

With more than one hundred pre-defined tools included in DALiM Software’s TWiST automated workflow appli-
cation, the workflow can be as simple or complex as desired. By inserting one or several of the pre-defined input 
tools in the workflow, you can input virtually any file format and output it as a PDF/X-1a compliant file. With an 
extensive range of transformation, filter, proof and move tools, the steps between the input and the PDF/X-1a 
generation can be as varied and comprehensive as required.

Input File PostScript Check 
(preflight)

PDF output Transmit
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With DALiM Software’s unique “PPD-Driven Workflow” system, processing a file through any PDF/X-1a generation 
workflow is as simple as printing the file to a printer, from a familiar Macintosh interface.

How To Generate PDF/X-1a Files

To generate PDF/X-1a files, the tool responsible in DALiM TWiST and SWiNG is called the O_PDF tool. Regardless of 
the workflow in which it sits, the following procedure is valid for setting up and subsequently printing files to 
the workflow from a Macintosh workstation:

1 In the SWiNG or TWiST Editor application, open the workflow template 
that you wish to have PDF/X-1a output.

2 Double-click the O_PDF icon.

3 Under the Standard tab, click PDF/X-1a in the Format list.

4 Keep the default for all other options in the Standard and Expert tabs.

5 Click Save.

6 Type a name for the workflow and click OK to save the settings.

7 Click OK to close the O_PDF interface.

8 In the TWiST or SWiNG application, choose Specific > ExportAsPrinter-
Queue.

9 Choose also Specific > Configure WFL’s Macintosh PPD.

10 In the Workflow tab, select the O_PDF tool.

11 Display the Basic Tool Details tab.
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12 You can now give the Macintosh operator the option to 
use the saved (predefined) settings, or allow the operator to 
change all or some of the settings. You may, for example, 
set the PDF_PredefinedSettings feature to Yes and set all 
other features to No, to force the operator to choose the 
predefined, secure, PDF/X-1a settings already created.

13 Click OK.

14 Choose DALiM > Close and save the workflow’s settings.

15 Update the SWiNG or TWiST server application.

The workflow is now ready to process any number of files 
directly from any Macintosh application:

1 On the Macintosh workstation, select the printer queue 
published by the SWiNG or TWiST Editor.

2 Open your Macintosh application (Quark XPress, for 
example).

3 Open the file you want to process.

4 Choose File > Print.

5 Click Printer.

6 From the Printer dialogue box that is now open, click 
General and choose Printer Specific Options 1.

7 Choose the saved settings in the O_PDF Predefined Settings pop-up menu.

8 Click Print. This prints the file to the Workflow’s input folder. The file is then processed as setup in the work-
flow, and the generated PDF/X-1a file is stored in a local or remote directory, as defined in the workflow’s setup.
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Notes

Using the “PPD Manager” application that ships as standard with all versions of DALiM TWIST and DALiM SWiNG, 
you can customize the displayed information that the Macintosh operator sees when printing to a PDF/X-1a 
output Workflow. The information can be customized to show, for example, customer or publication names, 
particular image resolutions, compression settings, etc.

With the addition of Dalim Software’s WEBLiNK application to DALiM TWiST and DALiM SWiNG, file upload, preflight 
information and complete PPD access is available to any client (Mac, PC, UNIX, etc.) via a standard web browser 
without the requirement of any application-specific browser plug-in.
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DDAP Association

DDAP Software Development Initiatives

The DDAP Association has taken the initiative to develop some PDF/X tools that check the conformance of 
PDF-documents to the PDF/X standards:

• DDAP PDF/X Verifier

• DDAP Digital Delivers

What is DDAP PDF/X Verifier?

Developed by Total Integration, DDAP PDF/X Verifier, version 2.0 is designed to streamline PDF/X adoption by 
enabling users to verify that files received in this format meet the requirements of the recently published ISO 
15930-1:2001 specification. 

"We envision this software being extremely useful to developers and users alike," states Alan Darling, DDAP Asso-
ciation Chair. "As PDF/X goes into full implementation, this tool will enable developers to test their software 
against the published standard. It will also give users confidence in integrating this standard with their digital 
workflows."

Features

• Verification support for PDF/X-1a (Mac/Windows) 

• Verification support for PDF/X-2 and 3 (Mac/Windows) to be developed once specification is published

• User-selectable preferences set for different levels of compliance
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• Interactive user interface shows progress and a simple "Pass" or "Fail" result

• Detailed report on all errors and inconsistencies

Why Do I Need it?

• If you create PDF/X-1 files, you need to verify them before you send them

• If you accept PDF/X-1 files, you need to verify them after you receive them

• If you are a developer and you want to make sure you comply with the PDF/X-1 standard, you need to verify 
your files

Cost

The cost of DDAP PDF/X Verifier is:

• $98* for members

• 128* for non-members

Plus $12 shipping & handling

*Prices subject to change without notice

DDAP PDF/X Verifier, Version 2 customers receive software that supports PDF/X-1a (Mac/Win). Free upgrades 
PDF/X-2 and 3 will be provided as they become available.
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What is DDAP Digital Delivers?

Designed to educate your staff, customers and suppliers on the advantages of using standard accredited file 
formats in digital delivery, “Digital Delivers” interactive CD ROM steps you through all the DDAP-recommended 
workflows and provides a solid foundation for building your digital ad strategy. The "How-to’s" and "Design 
your own Workflow" sections alone could become the core of your company training program. “Digital Delivers” 
will introduce, educate and simulate all the critical workflow issues for your staff, your customers and suppliers.

Features

This dynamic package:

• Identifies the key players and the critical roles they play in the digital ad process

• Explains all the basic terminology, gives an overview of digital workflow concepts and includes a glossary of 
common terms.

• Outlines all the workflow options, both DDAP-recommended and otherwise, presenting the advantages and 
disadvantages in clear and precise terms.

• Fully addresses the business issues of digital ad delivery and coaches you on building a digital ad team, 
publishing ad specs and communicating with advertisers.

• Provides a content-rich “Resources” section where you will learn "How To" prepare successful native appli-
cation files, and solid PostScript and PDF files.
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Fujifilm

PDF/X Support Within Fujifilm Celebrant Extreme

Within the Fujifilm Celebrant range of workflow products, the Celebrant Primer is the software module that is 
responsible for the creation of PDF/X files. In coming data can be either PostScript of PDF, which is then run 
through a series of processes to create PDF/X files. For processing of PDF/X data, Celebrant Extreme is ‘PDF/X aware’ 
and will render these files based on the information they contain.

Creating PDF/X Files

The Celebrant Primer is a software module at the front end of 
the Celebrant Extreme workflow whose function is to create 
print ready PDF files. Processes such as normalizing, font 
embedding, color management, trapping and preflighting 
take place within this module. If a PDF/X or PDF/X3 file is 
requested, then the processing parameters will be pre defined 
based on the respective PDF X specifications. Additional PDF 
tags (such as the trapping tag for PDF/X1a files) are also inserted 
into the PDF so that the file fully conforms to the PDF/X speci-
fication. At the end of this process the files can be run through 
the integrated Enfocus PitStop preflighter as a double check 
that the file is a valid PDF/X file.
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Processing PDF/X Files

Any Job Ticket created in Celebrant Extreme can be defined to 
be ‘PDF/X aware’. This avoids potential pitfalls of processing 
PDF/X files such as trapping a PDF/X file that has already been 
tagged as being trapped, or color managing a PDF/X1a file 
which requires no color management. For the processing of 
PDF/X3 files, the Job Ticket will define which ICC profiles are to 
be applied for proofing or final press color.
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Global Graphics Software

By now you’ll be familiar with an important aspect of the PDF/X standard – it not only describes what must be 
in a file (and what must not), but also sets out how a compliant reading application must process them. It’s only 
by using a compliant workflow that you can guarantee that you’ll generate the same output as at other sites, 
and that a pre-transmission proof will match the final, printed piece.

Current HarlequinTM RIPs

It’s your workflow as a whole that matters, rather than any single process within it, so you need to evaluate 
every part on its own and in combination with the rest. If you’re using Harlequin RIPTM version 5.3 or later that 
part of the process will probably already be very close to being PDF/X compliant - if you’re running a ‘Classic’ 
edition, you may only need to flip one switch to move from the default settings to PDF/X compliance. If you’re 
using a RIP from an OEM who provides a very different interface you’ll have to ask that OEM how to make this 
same change.

By default the RIP treats white objects that have been set to overprint as a special case – it essentially ignores 
the overprint request so that the white object doesn’t just disappear. This means that the default in-RIP sepa-
rations from a Harlequin RIP exactly match the output you would have produced if you’d printed directly from 
the design application with separations turned on. The PDF/X-1a specification was written to the least common 
denominator of RIP capabilities, which means that the Harlequin output must be downgraded to match what 
other RIPs can do in order to be compliant. 
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To make your Harlequin RIP PDF/X compliant, open the Edit Page Setup dialog 
box and click Color Options. Make sure that the option Drop white objects is 
selected.

In development

Explicit support for PDF/X-1:1999 was added in version 5.3 of the Harlequin RIP, first shipped nearly two years 
ago - that standard is now obsolescent, and should not be used when designing a new workflow. A future 
version of the Harlequin RIP, currently in development, will include explicit support for PDF/X-1a:2001 and 
PDF/X-3:2002. The support includes both verification that submitted files comply with PDF/X, and enforces 
compliant processing of those files.

As a general rule, the earlier an error in a file is discovered, the less it will cost to correct. If a designer finds a 
problem before he’s shipped the file out, he can usually fix it immediately. If it’s not discovered until the file 
reaches the printer there may be a long chain of contacts that need to be notified in order to re-send a corrected 
file. The worst case scenario is if a bad file is actually printed, in which case a reprint or make-good will probably 
be necessary. File validation steps throughout your workflow are therefore a sensible precaution.

The last proof that a designer makes before transmitting his file to a publisher or printer should be taken from 
the file that he will transmit. A proof printed from QuarkXPress does not necessarily provide an exact prediction 
of the appearance of a PDF/X file made from the same XPress document, for instance. In-RIP verification enables 
a single-pass “proof and verify” step that can be used immediately before a designer sends files to a publisher 
or printer. The same process can also be used by that publisher or printer immediately on receipt of the files.
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If your workflow is such that PDF/X files are supplied to the RIP used for final plate-making, you may also wish 
to have the RIP do a final verification that the files conform, just in case previous quality control steps miss a 
problem. Doing so does not slow the RIP down, and requires no operator intervention unless a non-conforming 
file is found. In those cases, the potential cost of letting a bad file through far outweighs the additional work 
that might be required to double-check that a specific file is OK to go to plate.

Clicking the PDF Options button on the page setup dialog allows you to 
specify what versions of PDF should be accepted.

Auto-detect types (the default) means that the RIP will automatically 
recognize PDF/X files and, when necessary, override some settings from 
the page setup to ensure that they are processed in a compliant way.

Any PDF up to 1.3 tells the RIP to treat all files as baseline PDF and not to apply any special processing to PDF/X 
files. This can be useful if you have a file that claims to be PDF/X compliant, but is not, and if you absolutely have 
to get it printed for any reason. Some workflows may end up producing files that still contain the flags that state 
that they are PDF/X compliant when they are not, especially when imposing pages, or compositing partial-page 
ads together, for instance. In those cases you don’t want to verify PDF/X compliance in the RIP and should select 
this option.

The other options, such as Only PDF/X-1a:2001 tell the RIP that any files that do not comply with the selected 
standard(s) should be rejected. Files that do comply will be processed as specified.

More details of Harlequin RIP solutions can be found at www.globalgraphics.com

HarlequinTM and Harlequin RIPTM are trademarks of Global Graphics Software Limited.

http://www.globalgraphics.com
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Heidelberg

Heidelberg products that process PDF/X-1a:2001 files

Heidelberg acknowledges the importance of Standards for the Printing and Publishing industry. Workflow devel-
opment for Heidelberg products is based on support for mainstream Standards - PDF and JDF/CIP4.

In addition, the importance of emerging Standards such as PDF/X is recognized for file exchange.

The following Heidelberg products will process PDF/X-1a:2001 files:

• PreFlow PDF Preflighting and Trapping - v2+

• Delta Technology RIP - version 7.0+

• MetaDimension Workflow - v2.6+

• SignaStation Imposition - 7.0+

• SuperTrap PDF Trapping - v3.0+

• Prinergy PDF Workflow Management Solution v2.07+

The NexPress 2100 Digital Press supports the emerging VDX Standard which includes PDF/X-1a as one of the 
supported file formats. It is also planned for MetaDimension v3.0 to generate PDF/X-3 files.
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Part 3: Enfocus Software PDF/X Solutions

Introduction

As a leading publisher of Adobe PDF tools, Enfocus Software saw the need to incorporate the emerging PDF/X 
standards into its products from the beginning. As part of its mission to be a leader in making PDFs easy and 
reliable for the marketplace, Enfocus Software has made sure that its technology offers full support for PDF/X 
creation and checking.

Topics

This part deals with the following topics:

• “Chapter 1: The Enfocus Software “Certified” PDF Technology” on page 66

• “Chapter 2: Creating Enfocus Certified PDF/X-1a Files from within Your Design Application” on page 83

• “Chapter 3: Creating Enfocus Certified PDF/X-1a Document from Existing PDF Documents” on page 96

• “Chapter 4: Receiving Enfocus Certified PDF/X-1a Documents” on page 101
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Chapter 1: The Enfocus Software “Certified” PDF Technology

Topics

This chapter deals with the following topics:

• “The “Portable Document Format” (PDF)” on page 67

• “The PDF Profile” on page 68

• “Enfocus Certified PDF” on page 70

• “The Preflight Report” on page 80
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The “Portable Document Format” (PDF)

PDF: a de facto standard for electronic file exchange

The process of exchanging electronic files is anything but infallible. The alternative? Adobe’s Portable Document 
Format (PDF). Indeed, PDF has become a de factor standard for electronic file exchange in recent years for obvious 
reasons:

• A PDF document contains all the necessary information for output (page layout, images, fonts, etc.).

• The interpretation of the PostScript file is done as the PDF document is generated, which enables you to inter-
vene if problems occur. Moreover, PDF is a less complex digital format than PostScript. Consequently, the RIP 
process can occur faster and is less prone to errors.

• The PDF format is independent of any application and platform: PDF documents can be viewed and changed 
in Microsoft Windows, on Mac OS and UNIX.

• The PDF format is object-oriented: each object can be changed in itself (e.g. using Enfocus PitStop Profes-
sional).

• The pages of a PDF document are self-contained: you can easily change their order, and extract or insert a 
page.

• A PDF document can be compressed without any loss of quality because different compression algorithms can 
be used for each type of object.

• PDF is truly a multimedia format: graphics can easily be reused and published across various media (Web, 
cd-rom,...).
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The PDF Profile

The PDF Profile is a technology developed by Enfocus Software which enables you to specify the quality standards 
for PDF document. The PDF Profile can be used at the time when the PDF document is created and to perform a 
preflight check later on.

Using a PDF Profile, you can check some 150 criteria in a PDF document. For each of these criteria, you can specify 
in the PDF Profile whether it has to be ignored, reported as information or as error.

For example:

• A PDF document which has to be printed in a four-color press should only contain CMYK colors and all fonts 
have to be embedded

• A PDF document which has to be printed with spot colors should not contain any RGB colors

Each property of a PDF document which does not meet the criteria as specified in the PDF Profile will be reported 
as a “problem”.

Certain problems can even be corrected automatically by the PDF Profile, e.g. ambiguous spot color definitions

When the PDF document is created, the PDF Profile is used to specify the job options of Acrobat Distiller. Conse-
quently, you do not have to specify these job options separately in this stage of the process.
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PDF Profiles

PDF Profiles can be used to preflight PDF documents. A PDF Profile is a collection of criteria which a PDF document 
must meet in order to be considered output-ready. For each criteria, we have specified:

• Whether or not it should be checked

• How it should be reported in the preflight report, i.e. as “Information” or as “Error”, if a non-compliant prop-
erty is detected

Certain criteria in the PDF Profiles contain an “automatic fix” for the detected problem: if a problem is detected, 
it will be corrected automatically by the PDF/X-1a profile.

RGB colors are an example of such a criterion, as shown in the illustration below. RGB colors should obviously 
not occur in PDF documents which have to be printed on an offset press. This criterion is checked in the PDF 
document and if RGB colors are detected, an error will appear in the preflight report.

You find an overview of the types of PDF/X-1a profiles in “Why PDF/X?” on page 11.
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Enfocus Certified PDF

About Certified PDF

Enfocus Certified PDF is a PDF workflow concept developed by Enfocus Software based on customer requests and 
feedback from industry experts. The Enfocus Certified PDF concept has been designed to address three funda-
mental issues faced by the majority of users implementing a PDF workflow:

• How to guarantee that a PDF document was successfully preflighted with a specific PDF Profile. See also 
“Preflighting in a Certified PDF workflow” on page 70

• How to maintain consistency between the source document(s) and the PDF document when (minor) changes 
can be applied to the PDF document throughout the workflow. “Document consistency” on page 71

• How to minimize risk and responsibility when changing a customer’s PDF document before final output. 
“Responsibility” on page 72

Preflighting in a Certified PDF workflow

A Certified PDF workflow supports the preflight process by:

• Offering the PDF document provider a simple and streamlined way to preflight a PDF document with a PDF 
Profile supplied by the PDF document recipient

• Including the PDF Profile and the corresponding preflight report in the PDF document. This way there can be 
no doubt about the preflight status of the PDF document

• Offering a straightforward user interface that enables the recipient of the PDF document to verify that the 
document has been preflighted successfully with a profile he or she provided
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The above-mentioned features help to:

• Motivate the PDF document provider to actually preflight his or her PDF documents

• Dramatically reduce the number of problems in files received from PDF document providers

Document consistency

PDF editing issues

PDF editing tools, such as Enfocus PitStop Professional, are very convenient for making intermediate or 
last-minute corrections in PDF documents. This saves you both time and money because you do not have to go 
back to the original application program to re-create the PDF document. Sometimes, it may even be more effi-
cient to make the changes directly in your PDF document. Enfocus PitStop Professional, for example, allows you 
to make global color changes throughout your PDF document. 

However, PDF editing also involves a risk: as soon as you edit and save a PDF document, you create a version of 
a document that is different from the original document you made using a word processor or a desktop 
publishing software. These inconsistencies are hard to manage, and may introduce problems in archiving or 
when the document is republished at a later date.

PDF editing in a Certified PDF workflow

To help reduce document consistency problems, the Certified PDF workflow features a mechanism that:

• Logs all the changes that are made to a Certified PDF document

• Stores these changes inside the Certified PDF document

Based on this information, an edit log —a human readable PDF report— can be generated.
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If consistency between the PDF document and the source file(s) is very important, you can use the edit log to 
change the source file(s) accordingly. To assist in this process, a Certified PDF document can also keep a reference 
to the source file(s) from which the PDF document was created. You can use this reference to make sure that the 
source file has not been edited since the PDF document was created.

See also:

• “References to the original source document” on page 77

• “The edit log file” on page 78

Responsibility

Responsibility issues

In addition to causing inconsistencies, changing a PDF document that was created by someone else can create 
ambiguity about who is ultimately responsible for the final result.

Many printers, service providers, etc. are extremely reluctant to make any changes to their customer’s documents 
for fear of having to assume responsibility if anything goes wrong. This includes issues that can be totally unre-
lated to the small correction applied.

Responsibility in a Certified PDF workflow

The Certified PDF workflow settles responsibility issues by:

• Providing a detailed log file of all the changes made to a PDF document

• Keeping track of the PDF editing process, i.e. who applied which change and when
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• Implementing a robust roll-back mechanism which allows you to easily return to a previously saved state —a 
“snapshot”— of your PDF document

• Offering the possibility to compare any two of these snapshots visually to detect and examine the differences

Snapshots and roll-back mechanism explained

In a Certified PDF workflow, a PDF document can go through various editing sessions, done by various users. A 
Certified PDF document “remembers” all the changes that were made during a given session and stores the 
information about these changes per session (“incrementally”) as you save your PDF document.

This way of managing and saving changes has a big advantage: You know exactly which changes have been 
made in which session and by whom. Moreover, these changes can be presented to you in the form of a “snap-
shot”: a “view” of the status of the PDF document at the time it was saved at the end of a session.

And if you use Enfocus PitStop Professional, you can do even more: You cannot only view the state of the PDF 
document in a given previous editing session, you can also save this snapshot as a separate PDF document. This 
is called the roll-back mechanism. When editing PDF documents, you may have experienced 
“one-change-too-far” situations, in which you made a change, got a undesired result but also saved the PDF 
document. No problem in a Certified PDF workflow: you can revert to any previously saved state of a PDF docu-
ment.

A snapshot is a visual representation of the state of a PDF document at the time it was saved after an editing 
session. You save a snapshot to revert to a previous version of your PDF document. However, you do not neces-
sarily have to save this snapshot at the end of each session. You can simply select any session from a list and 
save its snapshot at any stage in your workflow.
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What is an Enfocus Certified PDF document?

Any regular PDF document contains metadata, i.e. information 
about the document itself. The Document Summary dialog box of 
Adobe Acrobat, for example, contains metadata like:

• The document title

• The document’s subject

• The authoring software in which the original document was 
created (Creator)

An Enfocus Certified PDF document can be enriched with the 
following metadata:

• A reference to one or more source documents on which the 
PDF document was based

• A PDF Profile

• A preflight report

• User and system identification

• An edit log, listing all the changes done in the PDF document 
per editing session (the time in which the PDF document was 
opened, edited and saved)

• Session comments
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Certified PDF personal information

An Enfocus Enfocus Certified PDF document can contain two types 
of user identification: personal information and system informa-
tion. Each of these serves its own purpose:

• The personal information is your name and company contact 
details, together with a message, if any. You can fill this in so 
that people know how to reach you if they should have any ques-
tions about edit or preflight actions done in the PDF document.

• The system information consists of the details of the person 
who registered Enfocus Instant PDF and information taken from 
your operating system, network and computer. This information 
cannot be changed and is therefore a reliable source to pinpoint 
responsibility, for example. If people claim or disclaim responsi-
bility for a given change made in the PDF document, the system 
information will provide incontestable proof. This information 
will be used in the edit log to show who made which changes in 
a given session.
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Session comment

The Certified PDF mechanism in Enfocus PitStop Professional 
enables you to enhance the quality of your PDF workflow by adding 
comments to the edit log. Before sending your PDF document to the 
publisher for example, you may want to explain why given changes 
have been made.

You can add comment per editing session. A session is the time in 
which you edit and save a PDF document.

Job Info

Enfocus Certified PDF documents can be provided with job infor-
mation. Job information can be any kind of information about the 
PDF document which you would like to share with the person who 
will receive the PDF document. This can include, for example:

• The name, company address and contact details for whom the 
PDF document is (ultimately) intended.

• Any additional remarks which the recipient of the PDF document 
has to know. This can be, e.g., details about how the PDF docu-
ment should be printed or what should happen next with the PDF 
document.
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References to the original source document

You can add references in your Certified PDF document to one or 
more source files on which the PDF file was based. This does not 
only offer you or the PDF recipient a convenient way to find the 
respective source files, it also enables you to check whether these 
source files have changed since the time at which the Certified PDF 
workflow was started for this PDF document. Indeed, if you wish to 
“synchronize” the source file with the edited PDF document, you 
will use the edit log report to apply the changes from the PDF docu-
ment in the source document. It is then crucial to know that you 
are working in the correct version of the source file.
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The edit log file

The Certified PDF mechanism in Enfocus PitStop Profes-
sional keeps a record of every editing session of a Certified 
PDF document. Thus, all the changes made to the PDF 
document are logged chronologically in the PDF document. 
The changes can be logged in two different ways, 
depending on the tool they were made with:

• If you edit your PDF document with any of the Enfocus 
Certified PDF compliant plug-ins, such as Enfocus PitStop 
Professional or Enfocus PowerUp PDF, the changes are 
immediately saved in the edit log file. The edit log file will 
contain a detailed entry for each of the changes.

• If you edit your PDF document with non-compliant 
third-party PDF editing tools, Enfocus PitStop Professional 
will intercept and log them. However, the edit log file will 
contain no details on the changes nor on the product with 
which the changes were made.
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Document history

The Certified PDF mechanism in Enfocus PitStop 
Professional allows you to consult the history of your 
PDF document. This means that you can view a chro-
nological list of all the sessions that your Certified 
PDF document has run through.

The chronological list of sessions contains the 
following information:

• The Certified PDF product that “stamped” the 
session

• The person or company responsible for the session

• The end date and time of the session

At this point, you can compare sessions or save a session as a snapshot:

• Comparing two versions of your PDF document visually is useful to see visible changes “at a glance”. The idea 
is that you select two sessions and click a Compare Visually button. Enfocus PitStop Professional will then 
generate two snapshots showing the state of the PDF document at the end of the respective sessions and present 
these snapshots side by side on screen. 

• A snapshot is a visual representation of the state of a PDF document at the time it was saved after an editing 
session. You save a snapshot to revert to a previous version of your PDF document. However, you do not neces-
sarily have to save this snapshot at the end of each session. You can simply select any session from a list and 
save its snapshot at any stage in your workflow.
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The Preflight Report

Two types of problems

When a PDF document has been subjected to a preflight check, you receive a preflight report. This preflight report 
is a PDF document and consists of the following chapters:

Chapter Contents

Errors and Cautions (potential) problems according to the selected PDF Profile

General File Information information about the current PDF document, such as title, author, profile used, 
data format, etc.

Font Information all fonts used in the PDF document, along with their attributes (type of font, 
embedded or subset, etc.)

Color Information all color spaces (RGB, CMYK, etc.) used in the PDF document, with additional infor-
mation where required

Image Information all images in the PDF document, along with additional information (e.g. physical 
and effective resolution, page, angle, custom color functions, etc.)

OPI Information OPI usage in the PDF document
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The first page of the preflight report contains a list of problems detected in the PDF document. A reported 
problem is not necessarily an error. If the PDF document does not meet a given criterion in the PDF Profile, an 
error level will be assigned to the problem and it will be reported as such, i.e.:

• as “Error”

• as “Information”, preceded by the label 
“Caution”

Information (Caution)

A problem reported as “Information” (preceded 
by the label “Caution”) is not necessarily a 
problem. It rather indicates a specific property 
of the PDF document which requires your 
special attention.

For example, one of the checks in the profiles is “Page is empty”. This criterion it itself is not crucial: it does not 
make a PDF document unsuitable for print if the PDF document still contains blank pages. The “Caution” in the 
report, however, will draw your attention to the fact that the PDF document contains empty pages and you can 
check whether these pages are really necessary or delete them if they are not.

Errors

If the preflight report contains errors, the PDF document is definitely not ready for output. You can use the report 
to detect the errors and correct them, either in the PDF document or in the source files.

Errors & Cautions

Severity Description
✮ Error Font Palatino-Bold is not embedded
✘ Error Image without Filter found
✘ Error Text does not knock-out
✘ Error Page 17 is empty
✮ Caution Changed Producer to Unknown
✮ Caution Image compression changed
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For example, you will get errors if the PDF document contains RGB colors and if it is checked with a profile for 
four-color offset printing. Enfocus PitStop Professional offers a convenient way to correct this error in the PDF 
document itself. Moreover, it is a lot easier to correct color-related errors like these in the PDF document itself 
than in the source file(s). You can use the Global Change feature or an Action List in Enfocus PitStop Professional.

In some cases, the error is automatically corrected by a “fix” the PDF/X-1a profile. The report will tell you how 
the problem has been resolved, e.g. by means of messages like “Objects compressed” or “Converted color”. If 
problems have been resolved automatically by one of the PDF/X-1a profiles, the corresponding message will be 
described in this Ultimate PDF/X Guide.

Quick-find lists

This Ultimate PDF/X Guide provides an overview of all the error messages that may appear in the preflight report 
when a PDF document has been checked against on of the PDF/X-1a profiles. You will find a description of what 
caused the problem and a number of tips to resolve the problem. You can quickly find an error message in this 
guide by means of the quick-find lists. See “Description of the Errors and Cautions in the PDF Reports” on 
page 127.
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Chapter 2: Creating Enfocus Certified PDF/X-1a Files from within 
Your Design Application

Topics

This chapter deals with the following topics:

• “Creating an Instant PDF queue” on page 84

• “Creating an Enfocus Certified PDF document with Enfocus Instant PDF” on page 88

• “Using Adobe Acrobat Distiller Server and Enfocus PitStop Server to Create a Certified PDF Document” on page 93
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Creating an Instant PDF queue

What is an Instant PDF queue and what does it do?

An Instant PDF queue is a complete workflow scenario 
containing the following tasks: 

1 Converting a source document into a PDF document 
using Acrobat Distiller Job Options which are derived 
from the PDF/X profile

2 Starting an Enfocus Certified PDF workflow for the PDF 
document

3 Preflighting the PDF document

4 Saving the PDF document on a specific location

5 Sending the document via e-mail or FTP

An Instant PDF queue is like a “virtual printer”: the 
name of the queue appears on your computer in the 
Printers list or on your desktop. You also print your 
source documents to an Instant PDF queue the same way 
you would print them on a regular printer. But this is 
not altogether true. In reality, you start a complete 
workflow by clicking Print.

➍

➎

➊

➋

➌
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What does an Instant PDF queue consist of?

An Instant PDF queue is a collection of the following components: 

• A name

• A printer driver

• A profile

An Instant PDF queue can also contain the following information:

• The name and the contact details of the document designer

• The name, the contact details and the e-mail address of the recipient of the document

• The necessary details to automatically send the PDF document via FTP

• A description about the Instant PDF queue

• Job information

Checking before creating an Instant PDF queue

To create a new Instant PDF queue, the following must be installed on your computer:

• A PostScript driver, like for example Adobe PS Generic PostScript Printer

• The Adobe Acrobat program.

You also need the PDF/X-1a profiles.
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Method

To create an Instant PDF queue, proceed as follows: 

1 Choose File > Preferences > Enfocus Instant PDF 
(Acrobat 4) or Edit > Preferences > Enfocus Instant PDF 
(Acrobat 5) and check whether the following informa-
tion is filled in:

• The PostScript driver, like for example Acrobat 
Distiller

• The location where Acrobat Distiller is installed on 
your computer.

Tip: The Acrobat Distiller driver has been installed 
on your computer together with Adobe Acrobat and is 
suitable in most cases. You will find the latest 
versions of the PostScript drivers on Adobe’s site 
(www.adobe.com/products/printerdrivers).

2 Choose Certified PDF > Show Personal Info and fill 
in all the data.

3 Choose Certified PDF > Show Instant PDF Queues.

4 Click New.

5 Fill in a name and a description of the Instant PDF 
queue.

6 Click the PDF Profile tab and choose a PDF/X-1a 
profile.

www.adobe.com/products/printerdrivers 
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7 If necessary, you can change or complete part of 
the personal or job information

8 Click the Output tab and specify the name and 
location of your PDF document.

9 Click OK.

The name of the Instant PDF queue appears in the 
Enfocus Instant PDF Queues dialog box and:

• In the Printers list of Control Panel (Windows)

• On your desktop (Macintosh).



[ Creating an Enfocus Certified PDF document with Enfocus Instant PDF ]The Ultimate PDF/X Guide

88

Creating an Enfocus Certified PDF document with Enfocus Instant PDF

About printer drivers, PPDs and Instant PDF Queues

When you create and set up an Instant PDF queue, you will also use a default printer driver for this queue. It is 
important that you have a good understanding of what printer drivers and PPDs are and can do, because they 
will very much contribute to the quality and look of your PDF document.

You find a brief description of printer drivers and PPDs below. For more detailed information about printer 
drivers and the most recent versions, please visit the Adobe Web site (www.adobe.com/products/printerdrivers).

Printer drivers

Every printer which you install on your computer system has a printer driver. A printer driver is a utility that 
enables your applications, e.g. authoring or (graphic) design programs, to control the printer. Basically, a printer 
driver is necessary to transfer the data from your applications to the printer correctly. 

AdobePS is an example of a PostScript printer driver. 

PostScript Printer Description Files (PPD)

A PostScript printer does not only have a printer driver, but also a PostScript printer description file, abbreviated 
as PPD. Thanks to a PPD, you can access printer-specific features from within your authoring or design program.

www.adobe.com/products/printerdrivers
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For example, if you have a high-volume laser printer which 
can print pages double-sided to a mailbox and staple these 
sets, you will be able to select these options when you print 
a file. The PPD will present these options in a graphical user 
interface, as shown in the example.

In Microsoft Windows, a PostScript printer driver is always 
linked to a PPD. On the Macintosh, you can use different PPDs 
with the same printer driver.

Acrobat Distiller versus Acrobat Distiller

Confusion can arise when we talk about Acrobat Distiller. 
Indeed, Acrobat Distiller is not only the name of the applica-
tion you use to convert PostScript files into PDF files, it is also 
an example of a PPD. In this Ultimate PDF/X Guide, we will 
consistently mention the terms “Acrobat Distiller printer 
driver” on the one hand and “the program Acrobat Distiller” 
on the other.
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Creating Certified PDF documents the Enfocus way: the one-step process to an output-ready 
PDF file

Creating output-ready PDF documents the conventional way, i.e. without Enfocus Instant PDF, is not always 
easy. You have to change or check a large number of parameters in various software programs and at various 
stages in the process. And you may have to do this every time you create a new PDF document.

Moreover, what makes a PDF document “correct” or “output-ready”? A PDF document which looks okay on your 
computer screen is not necessarily output-ready. Only Enfocus Certified PDF documents which have been 
subjected to a preflight check with one of the PDF/X-1a profiles can offer this guarantee.

Enfocus Instant PDF allows you to create Enfocus Certified PDF documents which are output-ready. And you can 
create them in no time: in fact, you just have to print your document to an Instant PDF queue. The rest will occur 
automatically.

Method

To create an Enfocus Certified PDF PDF document, proceed as follows:

1 Open your source document in the software program in which it has been created, e.g. QuarkXPress or Adobe 
InDesign.
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2 Check the print settings in the original software 
program, e.g. settings related to page size, color and 
image resolution.

3 Print your document to an Instant PDF queue.

An output-ready Enfocus Certified PDF document is 
created automatically in the following steps:

1 Your source document is converted to a a PDF 
document using Acrobat Distiller Job Options which 
are derived from the PDF/X profile.

2 The PDF document is opened in Adobe Acrobat.
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3 An Enfocus Certified PDF workflow is started for the 
PDF document and the Start Enfocus Certified PDF 
Workflow appears in Adobe Acrobat. If necessary, you 
can add a reference to one of more source docu-
ment(s), fill in or change the personal information or 
job information. When finished, click OK.

4 The PDF document is subjected to a preflight check 
against the PDF/X-1a profile which is linked to the 
Instant PDF queue:

• If the PDF document meets all the criteria of the 
profile, it saved in the folder which you have speci-
fied in the Instant PDF queue. It can also be sent 
automatically by e-mail or FTP to a recipient which 
you have specified when you created the queue.

• If the PDF document contains errors, they will be 
reported as error or information in the preflight 
report and the PDF document will stay open in Adobe 
Acrobat. You can use the preflight report to make the 
necessary corrections in your source document or in 
the PDF document. The cautions or errors listed in the 
reports contain hypertext links. You can click them to 
display the location of the respective caution or error.
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Using Adobe Acrobat Distiller Server and Enfocus PitStop Server to 
Create a Certified PDF Document

Description

Using Adobe Acrobat Distiller Server in combination with Enfocus PitStop Server is the ideal solution if you have 
to create Certified PDF/X-1a documents in batch. You may wish to do this for a number of reasons:

• To relieve the workstation of the document designer to create the PostScript file.

• To use the performance and resources of the server to process large files which may be impossible to process 
on less powerful workstations.

• To centralize the setup and management of the PDF creation process.

Setting up such a configuration requires a certain level of computer literacy. Configuring the Job Options of 
Acrobat Distiller, e.g., may be quite technical and complicated.

The configuration depends on the software and hardware platform and therefore, the installation cannot be 
explained at length in this Ultimate PDF/X Guide. Please refer to our knowledge base article on the Enfocus Web 
site for a detailed description. You find this article on www.enfocus.com > Support > Knowledge Base. Select the 
product PitStop Server and open the article “Configuring Distiller Server and PitStop Server to create Enfocus Certi-
fied PDF documents.

www.enfocus.com
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Method

The system administrator has to create a workflow (or 
“queue”) on the server and specify a number of 
processing instructions. He or she can do this as 
follows:

1 Create and configure a “drop folder” on the server.

The users will save their PostScript files in this drop 
folder to create PDF documents with processing 
instructions which are specific for this queue. For more 
information about creating processing files, please 
refer to the user guide of your authoring or design soft-
ware.

2 Create an input hot folder for Adobe Acrobat Distiller 
Server and specify the job options, the output folder 
and other properties. Refer to our knowledge base 
article mentioned above for technical details.

The “In” folder of Distiller Server corresponds to the 
drop folder. As soon as Distiller Server finds a PostScript 
file in the “In” folder, it will convert it to a PDF docu-
ment and move this file to the “Out” folder.

➊

➋
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3 Configure a hot folder for Enfocus PitStop Server and specify a PDF Profile and the various output folders, 
depending on the processing result (OK, error or information). Also select the option to make incoming PDF docu-
ments Enfocus Certified.

The input folder of the hot folder corresponds to the “Out” folder of Distiller Server.
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Chapter 3: Creating Enfocus Certified PDF/X-1a Document from 
Existing PDF Documents

Topics

This chapter deals with the following topics:

• “Starting an Enfocus Certified PDF Workflow for a PDF Document” on page 97

• “Checking the Enfocus Certified PDF Workflow Status” on page 99
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Starting an Enfocus Certified PDF Workflow for a PDF Document

Description

When you have started an Enfocus Certified PDF workflow for a PDF document, you can enrich it with Enfocus 
Certified PDF information, i.e.:

• A reference to one or more source document

• An embedded PDF Profile

• Comment about a given “session”, i.e. each time you open, edit and save a PDF document

Moreover, all modifications, preflight checks and even different versions are saved in the PDF document, so that 
you can always consult them later or even revert to one of the previously saved versions.

Method

Proceed as follows to start an Enfocus Certified PDF workflow for a PDF document:

1 Open the PDF document in Adobe Acrobat.

2 Choose Certified PDF > Start or click the button.
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3 Select a PDF/X-1a profile. You can also add a refer-
ence to one or more source files and add comments 
about the present session.

4 A dialog box appears prompting you to preflight your 
PDF document later or now. Click the Now button

A preflight check is performed on the PDF document and a preflight 
report appears. You can use this preflight report to make the 
required corrections in the PDF document or in the original source 
files.
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Checking the Enfocus Certified PDF Workflow Status

Description

The Enfocus Certified PDF status button ( ,  or )shows you the status of a PDF document in the Enfocus 
Certified PDF workflow at a glance. You can find this button in the File toolbar of Adobe Acrobat.

Method

Proceed as follows to check the Enfocus Certified PDF workflow status of a PDF document:

1 Open a PDF document in Adobe Acrobat.

2 Check the Enfocus Certified PDF status button in the File toolbar of Adobe 
Acrobat:

• If the button looks like this , it means that the Enfocus Certified PDF 
workflow has not been started yet for the PDF document. Click this button to 
start the workflow. See also “Starting an Enfocus Certified PDF Workflow for a 
PDF Document” on page 97.

• If the icon shows a green check mark , it means that the PDF Profile and 
its result are correct. The PDF document complies with the PDF/X profile.

• If the button shows a red cross , it means that the PDF document is not 
ready for output. Proceed with step 3.

3 Click the red cross button ( ) to find the cause of the problem:
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• The Enfocus Certified PDF profile embedded in the PDF 
document does not correspond to one of the PDF/X-1a profiles 
in your Enfocus PitStop PDF Profile Control Panel. Choose Certi-
fied PDF > Edit Properties and select one of the PDF/X-1a 
profiles in the list. These are the same profiles which you find 
in the Enfocus PitStop PDF Profile Control Panel. If Enfocus 
PitStop Professional is not installed on your computer, you can 
disable this comparison of the PDF Profiles in the Preferences. 
Choose File (Acrobat 4) or Edit (Acrobat 5) > Preferences, 
Enfocus Certified PDF and make sure the corresponding option 
is cleared.

• The PDF document has not been preflighted yet, or it has 
been preflighted and contains errors. Click Show Report and 
use the report to make the necessary corrections in the PDF 
document or in the original source file.
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Chapter 4: Receiving Enfocus Certified PDF/X-1a Documents

Topics

This chapter deals with the following topics:

• “Checking Enfocus Certified PDF Files” on page 102

• “Checking the PDF Documents Interactively with Enfocus PitStop Professional” on page 105

• “Checking the PDF Documents Automatically with Enfocus PitStop Server” on page 109

• “Resolving Reported Problems” on page 115
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Checking Enfocus Certified PDF Files

Description

If you receive PDF “Enfocus Certified” files from your client, you can use them confidently. The term “Enfocus 
Certified PDF” is a guarantee of quality.

Normally, you only have to check the status of Certified PDF files. It directly appears via the Enfocus Certified PDF 
Status Icon on the Adobe Acrobat toolbar. If you use Enfocus PitStop Server, this check happens automatically 
(see “Checking the PDF Documents Automatically with Enfocus PitStop Server” on page 109).

Method

To check the status of a document in an Enfocus Certified PDF workflow, proceed as follows:

1 Open the PDF document in Adobe Acrobat.

2 Check the Enfocus Certified PDF Status Icon above in the toolbar:

• If the icon shows a green check mark , it means that the PDF Profile and 
its result are correct. The PDF document complies with the PDF/X profile.

• If the icon shows a red cross , the document is not yet output-ready. 
Proceed with step 3.
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If the screen displays this icon , it means no Enfocus 
Certified PDF workflow has yet been launched for the 
current document. Click the icon to start the Enfocus 
Certified PDF workflow.

3 Click the red cross icon  to check the cause of the 
problem:

• The embedded Enfocus Certified PDF Profile does not 
match one of the PDF Profiles in the Enfocus PDF control 
panel. Choose Certified Workflow and Edit Properties 
and click a PDF Profile in the Enfocus PDF control panel. 
If Enfocus PitStop Professional is not installed, you can 
deactivate this additional check of the profiles via Pref-
erences. Choose File (Acrobat 4) or Edit (Acrobat 5) and 
click Preferences, Enfocus Certified PDF and make sure 
the selection is not checked (“The Certified PDF Profile 
has to match one of those in the database of the PDF 
Profiles”).
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• The document has not yet been checked or has been 
checked but contains errors. Click Show Report and edit 
the PDF document. If necessary, send the PDF document 
back to its author together with the report so that he can 
edit the original documents and deliver a new PDF file. 
If you can modify the Enfocus Certified PDF document, 
you should still send the corrected PDF file to its author. 
He can then precisely check which modifications were 
made thanks to the compare functions of Enfocus Certi-
fied PDF: “Visually” and “Using the Edit Log”, which are 
accessible via the History button in the Certified PDF 
menu. This will enable him to edit the original docu-
ments in the same way, so that the same errors do not 
occur in later versions.
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Checking the PDF Documents Interactively with Enfocus PitStop 
Professional

Description

Enfocus PitStop Professional enables you to perform an interactive preflight check on a PDF document. This 
means you will open the PDF document in Adobe Acrobat and check some of its properties with a predefined PDF 
Profile. You can then use the report to correct the errors or make the author correct them.

Method

To check a PDF document interactively, proceed as 
follows:

1 Open the PDF document which has to be checked.

2 Select the Window menu and choose Pitstop 
Preflight Control Panel.

3 In the Administration tab, click Import.
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4 Select the profile you want to check the PDF docu-
ment with and click Open.

The profile appears in the Enfocus PDF Control Panel.



[ Enfocus Software PDF/X Solutions ] The Ultimate PDF/X Guide

107

5 In the Executing tab, click Create Report. The PDF 
document is checked and the report is displayed. You 
can use this report to correct the errors or make the 
author correct them.

Detection of errors in the preflight report

The report may not contain any error. If the 
preflighting finds some errors in the PDF document, 
the author will have to correct them via his design 
program or directly in the PDF document with Enfocus 
PitStop Professional. The cautions or errors listed in 
the reports contain hypertext links. You can click 
them to display the location of the respective caution 
or error.
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Printing a document

Unless you have a PDF workflow, Adobe Acrobat is not enough to send a PDF document to the image setter with 
the right printer, color separation and overprint settings. You need additional tools. Check your prepress provider 
for more information.
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Checking the PDF Documents Automatically with Enfocus PitStop 
Server

Description

Enfocus PitStop Server enables you to check your PDF documents automatically. You only need to create a hot 
folder in which you include one of the PDF/X profiles. As soon as a PDF document is put into an input folder of 
the hot folder, it is automatically checked and, depending on the result of this preflighting, moved to one of the 
output folders:

• The OK folder, if the PDF document does not contain any errors but maybe warnings, meaning that it is 
output-ready

• The error folder, if the PDF document contains errors, meaning that it is not output-ready
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Method

To check your PDF documents automatically, proceed as follows:

1 Create the following folders in Explorer (Windows) 
or Finder (Macintosh):

• An Input folder for the incoming PDF documents

• An OK folder for the PDF documents that are 
output-ready, without any errors 

• An Error folder for the PDF documents containing 
errors

• An Originals folder for the original versions of the 
incoming PDF documents

• A folder for reports on PDF documents which were 
processed successfully and which are thus 
output-ready

• A folder for reports on PDF document which contain 
errors

2 In the Enfocus PitStop Server Control Panel, click 
New to create a new hot folder.

3 Name your hot folder and, if necessary, fill in a 
description in the Description area of the hot folder.
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4 Display the Folders tab and specify the input 
folder and the output folders.

5 Click the button and specify the required 
folders.
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6 Click the Action List and PDF Profile tab to add 
one of the PDF/X profiles.

7 Select a PDF/X profile in the list of available PDF 
Profiles and click Select.
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8 If necessary, click the Certified PDF tab.

Select either one of the following options:

• Click Change Certified PDF Profile to hot folder 
PDF Profile to use the PDF Profile of the hot folder 
instead of the Enfocus Certified PDF profile 
embedded in the PDF document. 

• Select Make document Certified to start an 
Enfocus Certified PDF workflow for incoming 
non-certified PDF documents. These documents 
are enriched with Enfocus Certified PDF informa-
tion and get the PDF Profile of the hot folder 
embedded. 

Tip: You can select not to certify the documents 
only to save the PDF document as if it was a new 
document: without Enfocus Certified PDF informa-
tion and without profile or preflighting report. But 
we advise you not to do so at this stage.
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9 Display the general properties, click Activate hot 
folder and select a priority level. Each PDF document 
in the input folder of the hot folder is automatically 
compared to the PDF Profile of this hot folder or to the 
embedded profile. The PDF document will be moved 
to the right folder depending on the result of the 
preflighting.

• The documents in the OK folder are output-ready

• The documents in the error folder contain errors. 
You can handle these documents yourself or send 
them back to the author together with the error 
reports so that he can correct them.
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Resolving Reported Problems

Problems in the PDF document which have been detected by the PDF Profiles may affect the following stages in 
the workflow:

• The PDF document may not pass through the workflow.

• The PDF document or the original files may need to be corrected.

Ideally, you send the PDF document provider an Enfocus Certified PDF document with its preflight report and let 
the document designer take care of the required corrections in the PDF document. An Enfocus Certified PDF docu-
ment enables the document designer to keep track of all the changes done in a PDF document. This Ultimate 
PDF/X Guide offers the document designer an explanation of and a solution to each problem. The designer can 
make the necessary corrections in the original source files.

Another option is to make the corrections in the PDF document by using Enfocus PitStop Professional. This may 
even be a better option in some cases, such as performing global color changes in various objects (text and 
graphics) which may have been created in a variety of software products and assembled in a single document. 
Sometimes, it may even be necessary to meet the deadline or simply because you do not have the time to find 
and edit the original source files. If so, bear in mind that the corrections are only done in the PDF documents 
and not in the original source files. Some “post-synchronization” may be necessary between the PDF documents 
and the original source files: the original source files have to be corrected correspondingly.

This Ultimate PDF/X Guide presents an overview of all the error messages that may appear in a preflight report 
after a preflight check has been performed with one of the PDF/X-1a profiles. Each error messages provides a 
detailed description of the problem and a procedure or tips to resolve it. You can easily find a description of a 
specific error in this Ultimate PDF/X Guide by means of the quick-find lists. See “Description of the Errors and 
Cautions in the PDF Reports” on page 127.
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Part 4: Beyond PDF/X

Introduction

When the PDF/X standards were created, they addressed a 'common' set of issues across many different print 
publishing disciplines. These include magazine, newspaper, book, commercial, packaging, etc. However, each 
of these disciplines may have very specific production requirements that need to be addressed separately, and 
go Beyond the PDF/X specifications. 

In fact, even within each of the disciplines there may be different requirements. Other than the issue of CMYK 
vs. Device Independent Color which are addressed in the PDF/X-1a vs. PDF/X-3 specifications respectively, these 
requirements could be things like image resolution, maximum density, specific page sizes, etc.

While the common issues are covered in the various PDF/X specifications, the other more application or discipline 
specific issues need to be addressed through a combination of the use of different software tools, settings, and 
operator training.

Generally, the industry is moving toward identifying these additional settings and setting files as PDF/X Plus. For 
example, you may see these settings and setting files with names like; PDF/X Plus for Magazines, PDF/X Plus for 
Commercial Printing, or PDF/X Plus for Flexo Packaging, etc.

Please note that the following section includes some examples of PDF/X Plus setting files (profiles) that were 
developed for use with Enfocus products, however similar setting files will also be available from many of the 
other PDF/X solution providers. 

Be sure to ask your output provider for setting files or individual settings that will address these production 
needs that beyond PDF/X to ensure a successful print publishing process.
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Topics

This part deals with the following topics:

• “PDF/X Plus” on page 119

• “PDF/X Plus Magazines Recommendations” on page 120

• “PDF/X Plus Newspapers Recommendations” on page 122

• “PDF/X Plus Commercial Printing Recommendations” on page 124

• “Reporting of Errors and Cautions Using PDF/X Plus Profiles” on page 126
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PDF/X Plus

Profiles

In order to further streamline the specific PDF workflows, Enfocus Software developed PDF/X Plus Profiles which 
add additional checks to the PDF/X-1a specifications. This will restrict the PDF file even more, ensuring perfect 
printability within a specific production environment.

Specific PDF/X Plus Profiles have been created for the following environments:

• Magazines

• Newspapers

• Commercial Printing

All three Profiles are, of course, fully compliant with the PDF/X-1a standard.

Additions

The following sections give a concise overview of the different checks that have been added to the PDF/X-1a 
requirements in order to meet the needs of the different production environments:

• “PDF/X Plus Magazines Recommendations” on page 120

• “PDF/X Plus Newspapers Recommendations” on page 122

• “PDF/X Plus Commercial Printing Recommendations” on page 124.
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PDF/X Plus Magazines Recommendations

The following checks have been added to the PDF/X-1a PLUS Magazines v2 Profile in order to ensure perfect print-
ability of your PDF documents in a magazine environment: 

Generic PDF/X Plus checks For more information, see...

Document Creator should not be Adobe 
PDFWriter

“Errors and Cautions of the Category “Document Info”” on 
page 160

Page Size should be equal “Errors and Cautions of the Category “Page Size”” on page 169

Page Orientation should be equal “Errors and Cautions of the Category “Page Size”” on page 169

Document should not contain more than 4 
separations

“Errors and Cautions of the Category “Spot Color”” on page 184

Multiple Master and Double Byte fonts 
should not be used

“Errors and Cautions of the Category “Font Type”” on page 195

White text should be set to knock out “Errors and Cautions of the Category “Text”” on page 201

Document should not contain annotations “Errors and Cautions of the Category “Annotations”” on 
page 217
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Magazine-specific checks For more information, see...

Document should not contain more than 
one page

“Errors and Cautions of the Category “Page Info”” on page 170

Document should not contain TrueType fonts “Errors and Cautions of the Category “Font Type”” on page 195

Text size should not be smaller than 5pt if it 
appears on one separation only

“Errors and Cautions of the Category “Text”” on page 201

Text size should not be smaller than 9pt if it 
appears on more than one separation

“Errors and Cautions of the Category “Text”” on page 201

Resolution of grayscale and color images 
should not be lower than 150 dpi

“Errors and Cautions of the Category “Image Resolution”” on 
page 210

Resolution of black-and-white images 
should not be lower than 600 dpi

“Errors and Cautions of the Category “Image Resolution”” on 
page 210

Ink coverage should not exceed 300% “Errors and Cautions of the Category “Process Color”” on 
page 173
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PDF/X Plus Newspapers Recommendations

The following checks have been added to the PDF/X-1a PLUS Newspapers v2 Profile in order to ensure perfect 
reproduction of your PDF documents in a newspaper printing environment: 

Generic PDF/X Plus checks For more information, see...

Document Creator should not be Adobe 
PDFWriter

“Errors and Cautions of the Category “Document Info”” on 
page 160

Page Size should be equal “Errors and Cautions of the Category “Page Size”” on page 169

Page Orientation should be equal “Errors and Cautions of the Category “Page Size”” on page 169

Document should not contain more than 4 
separations

“Errors and Cautions of the Category “Spot Color”” on page 184

Multiple Master and Double Byte fonts 
should not be used

“Errors and Cautions of the Category “Font Type”” on page 195

White text should be set to knock out “Errors and Cautions of the Category “Text”” on page 201

Document should not contain annotations “Errors and Cautions of the Category “Annotations”” on 
page 217
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Newspaper-specific checks For more information, see...

Document should not contain more than 
one page

“Errors and Cautions of the Category “Page Info”” on page 170

Document should not contain TrueType fonts “Errors and Cautions of the Category “Font Type”” on page 195

Text size should not be smaller than 8pt if it 
appears on one separation only

“Errors and Cautions of the Category “Text”” on page 201

Text size should not be smaller than 10pt if it 
appears on more than one separation

“Errors and Cautions of the Category “Text”” on page 201

Resolution of grayscale and color images 
should not be lower than 100 dpi

“Errors and Cautions of the Category “Image Resolution”” on 
page 210

Resolution of black-and-white images 
should not be lower than 600 dpi

“Errors and Cautions of the Category “Image Resolution”” on 
page 210

Ink coverage should not exceed 240% “Errors and Cautions of the Category “Process Color”” on 
page 173
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PDF/X Plus Commercial Printing Recommendations

The following checks have been added to the PDF/X-1a PLUS Commercial CMYK v1 Profile in order to ensure perfect 
reproduction of your PDF documents in a commercial printing environment: 

Generic PDF/X Plus checks For more information, see...

Document Creator should not be Adobe 
PDFWriter

“Errors and Cautions of the Category “Document Info”” on 
page 160

Page Size should be equal “Errors and Cautions of the Category “Page Size”” on page 169

Page Orientation should be equal “Errors and Cautions of the Category “Page Size”” on page 169

Document should not contain more than 4 
separations

“Errors and Cautions of the Category “Spot Color”” on page 184

Multiple Master and Double Byte fonts 
should not be used

“Errors and Cautions of the Category “Font Type”” on page 195

White text should be set to knock out “Errors and Cautions of the Category “Text”” on page 201

Document should not contain annotations “Errors and Cautions of the Category “Annotations”” on 
page 217
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Commercial printing-specific checks For more information, see...

Text size should not be smaller than 5pt if it 
appears on one separation only

“Errors and Cautions of the Category “Text”” on page 201

Text size should not be smaller than 8pt if it 
appears on more than one separation

“Errors and Cautions of the Category “Text”” on page 201

Text should not use artificial bold style “Errors and Cautions of the Category “Font Style”” on page 199

Resolution of grayscale and color images 
should not be lower than 150 dpi

“Errors and Cautions of the Category “Image Resolution”” on 
page 210

Resolution of black-and-white images 
should not be lower than 600 dpi

“Errors and Cautions of the Category “Image Resolution”” on 
page 210

Ink coverage should not exceed 340% “Errors and Cautions of the Category “Process Color”” on 
page 173
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Reporting of Errors and Cautions Using PDF/X Plus Profiles

Problems in the PDF document which have been detected by the PDF/X Plus Profiles may affect the following 
stages in the workflow:

• The PDF document may not pass through the workflow.

• The PDF document or the original files may need to be corrected.

Ideally, you send a PDF document to the provider, along with its preflight report, and let the document designer 
take care of the required corrections in the PDF document. This Ultimate PDF/X Guide offers the document 
designer an explanation of and a solution to each problem. The designer can make the necessary corrections in 
the original source files.

Another option is to make the corrections in the PDF document by using one of the many software solutions 
presented in this guide. This may even be a better option in some cases, such as performing global color changes 
in various objects (text and graphics) which may have been created in a variety of software products and assem-
bled in a single document. Sometimes, it may even be necessary to meet the deadline or simply because you do 
not have the time to find and edit the original source files. If so, bear in mind that the corrections are only done 
in the PDF documents and not in the original source files. Some “post-synchronization” may be necessary 
between the PDF documents and the original source files: the original source files have to be corrected corre-
spondingly.

This Ultimate PDF/X Guide presents an overview of all the error messages that may appear in a preflight report 
after a preflight check has been performed with one of the PDF/X-1a Profiles. Each error messages provides a 
detailed description of the problem and a procedure or tips to resolve it. You can easily find a description of a 
specific error in this Ultimate PDF/X Guide by means of the quick-find lists. See “Description of the Errors and 
Cautions in the PDF Reports” on page 127.
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Part 5: Description of the Errors and Cautions in the PDF Reports

Introduction

This part lists the errors and cautions which may be reported when you execute one of the PDF/X profiles. 
Although these (potential) problems are described here in the context of Enfocus PDF/X profiles, they are not 
restricted to Enfocus workflows only: they may occur in any PDF-based workflow, using a variety of PDF/X soft-
ware solutions. Check with your specific publisher or printer to ensure that these or any other settings or profiles 
do reflect their specific requirements prior to use.

You can use the quick-find lists to find the description of a specific error or caution.

Topics

You can find the quick-find lists for each of the PDF/X-1a profiles on the following pages:

• “List of Errors and Cautions in the Profile PDF/X-1a:2001 v2” on page 129

• “List of Errors and Cautions in the Profile PDF/X-1a PLUS Magazines v2” on page 131

• “List of Errors and Cautions in the Profile PDF/X-1a PLUS Newspapers v2” on page 135

• “List of Errors and Cautions in the Profile PDF/X-1a PLUS Commercial CMYK v1” on page 139

• “List of Errors and Cautions by Category” on page 143

• “Alphabetical List of Errors and Cautions” on page 151
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List of Errors and Cautions in the Profile PDF/X-1a:2001 v2

Cautions

Document encoding changed to binary ............................................................................................................... [ 158 ]

Moved objects outside of printable area .............................................................................................................. [ 226 ]

Not all pages in the document have the same size .................................................................................................. [ 169 ]

Removed actions ............................................................................................................................................[ 221 ]

Spot color “X” and spot color “Y” have the same CMYK values .................................................................................... [ 187 ]

Text point size <n>, colored with 6 or more color plates, is less than 6.00 points ............................................................ [ 202 ]

Errors

Alternative color space is not CMYK or Gray ........................................................................................................... [ 184 ]

Changed Page Box Layout to match the Press Layout specifications .............................................................................. [ 164 ]

Changed Title, Producer or Creator to Unknown ..................................................................................................... [ 160 ]

Changed trapped flag to false ........................................................................................................................... [ 159 ]

Creation and/or Modification date info added ........................................................................................................[ 161 ]

Custom transfer function removed ..................................................................................................................... [ 189 ]

Document has security .................................................................................................................................... [ 162 ]
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Document needs repair on open ........................................................................................................................ [ 158 ]

Font "X" has been embedded .......................................................................................................................... [ 200 ]

Found objects with transparency settings ............................................................................................................. [ 194 ]

Halftone phases removed ................................................................................................................................ [ 190 ]

Image compression changed ............................................................................................................................ [ 215 ]

Process color – converted color ..........................................................................................................................[ 173 ]

Removed alternate images ................................................................................................................................ [ 211 ]

Removed OPI ................................................................................................................................................ [ 216 ]

Rendering intent removed ............................................................................................................................... [ 189 ]
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List of Errors and Cautions in the Profile PDF/X-1a PLUS Magazines v2

Cautions

Changed image resolution ................................................................................................................................[ 213 ]

Document encoding changed to binary ............................................................................................................... [ 158 ]

Font “X” is a TrueType font ............................................................................................................................... [ 195 ]

Font “X” is a Type 3 font .................................................................................................................................. [ 196 ]

Image is rotated ........................................................................................................................................... [ 208 ]

Indexed color is used ..................................................................................................................................... [ 182 ]

Invisible object removed ................................................................................................................................. [ 207 ]

Not all pages in the document have the same size .................................................................................................. [ 169 ]

Removed embedded PostScript fragment ............................................................................................................. [ 222 ]

Spot color “X” and spot color “Y” have the same CMYK values .................................................................................... [ 187 ]

Text point size <n> is less than 5.0 ..................................................................................................................... [ 201 ]

Text point size <n>, colored with 6 or more color plates, is less than 6.00 points ............................................................ [ 202 ]

X and Y scaling of image differ 3 % .....................................................................................................................[ 209 ]
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Errors

Alternative color space is not CMYK or Gray ........................................................................................................... [ 184 ]

Annotation lies inside printable area .................................................................................................................. [ 225 ]

Annotation setting changed to non-printing ......................................................................................................... [ 218 ]

Black text is set to overprint .............................................................................................................................[ 204 ]

Changed line width .......................................................................................................................................[ 206 ]

Changed Page Box Layout to match the Press Layout specifications .............................................................................. [ 164 ]

Changed trapped flag to false ........................................................................................................................... [ 159 ]

Custom black generation function removed .......................................................................................................... [ 193 ]

Custom halftone function removed ......................................................................................................................[ 191 ]

Custom transfer function removed ..................................................................................................................... [ 189 ]

Custom undercolor removal function removed ....................................................................................................... [ 193 ]

Document contains actions .............................................................................................................................. [ 220 ]

Document contains ambiguously defined spot colors ............................................................................................... [ 184 ]

Document has security .................................................................................................................................... [ 162 ]

Document needs repair on open ........................................................................................................................ [ 158 ]

Effective resolution of color or grayscale images is less than 100 dpi, or, Effective resolution of single-bit black-and-white images is less
than 600 dpi ................................................................................................................................................ [ 211 ]

Font "X" has been embedded .......................................................................................................................... [ 200 ]
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Font “X” is a MultipleMaster font ....................................................................................................................... [ 196 ]

Font “X” uses an artificial bold, italic or outline style ............................................................................................... [ 199 ]

Found objects with transparency settings ............................................................................................................. [ 194 ]

Halftone phases removed ................................................................................................................................ [ 190 ]

Image compression changed ............................................................................................................................ [ 215 ]

Image contains alternates that are default for printing ............................................................................................ [ 210 ]

Invisible object removed .................................................................................................................................[ 205 ]

Number of nodes <n> in the single path is more than 500 .......................................................................................[ 206 ]

Page <n> is empty ......................................................................................................................................... [ 170 ]

Process color – converted color ..........................................................................................................................[ 173 ]

Removed annotation .......................................................................................................................................[ 217 ]

Removed OPI ................................................................................................................................................ [ 216 ]

Renamed spot color .......................................................................................................................................[ 188 ]

Rendering intent removed ............................................................................................................................... [ 189 ]

Spot color – converted color .............................................................................................................................[ 188 ]

Text does not knock out ..................................................................................................................................[ 205 ]

Total ink coverage of flat CMYK is larger than 310% .................................................................................................. [ 183 ]
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List of Errors and Cautions in the Profile PDF/X-1a PLUS Newspapers v2

Cautions

Changed image resolution ................................................................................................................................[ 213 ]

Document encoding changed to binary ............................................................................................................... [ 158 ]

Font “X” is a TrueType font ............................................................................................................................... [ 195 ]

Font “X” is a Type 3 font .................................................................................................................................. [ 196 ]

Image is rotated ........................................................................................................................................... [ 208 ]

Indexed color is used ..................................................................................................................................... [ 182 ]

Invisible object removed ................................................................................................................................. [ 207 ]

Not all pages in the document have the same size .................................................................................................. [ 169 ]

Removed embedded PostScript fragment ............................................................................................................. [ 222 ]

Spot color – converted color .............................................................................................................................[ 188 ]

Spot color “X” and spot color “Y” have the same CMYK values .................................................................................... [ 187 ]

Text point size <n> is less than 9.0 .................................................................................................................... [ 201 ]

Text point size <n>, colored with 6 or more color plates, is less than 6.00 points ............................................................ [ 202 ]

X and Y scaling of image differ 3 % .....................................................................................................................[ 209 ]
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Errors

Alternative color space is not CMYK or Gray ........................................................................................................... [ 184 ]

Annotation lies inside printable area .................................................................................................................. [ 225 ]

Annotation setting changed to non-printing ......................................................................................................... [ 218 ]

Black text is set to overprint .............................................................................................................................[ 204 ]

Changed line width .......................................................................................................................................[ 206 ]

Changed Page Box Layout to match the Press Layout specifications .............................................................................. [ 164 ]

Changed Title, Producer or Creator to Unknown ..................................................................................................... [ 160 ]

Changed trapped flag to false ........................................................................................................................... [ 159 ]

Creation and/or Modification date info added ........................................................................................................[ 161 ]

Custom black generation function removed .......................................................................................................... [ 193 ]

Custom halftone function removed ......................................................................................................................[ 191 ]

Custom transfer function removed ..................................................................................................................... [ 189 ]

Custom undercolor removal function removed ....................................................................................................... [ 193 ]

Document contains actions .............................................................................................................................. [ 220 ]

Document contains ambiguously defined spot colors ............................................................................................... [ 184 ]

Document has security .................................................................................................................................... [ 162 ]

Document needs repair on open ........................................................................................................................ [ 158 ]
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Document Producer info string contains Acrobat PDFWriter .........................................................................................[ 161 ]

Effective resolution of color or grayscale images is less than 100 dpi, or, Effective resolution of single-bit black & white images is less than
600 dpi ....................................................................................................................................................... [ 211 ]

Font "X" has been embedded .......................................................................................................................... [ 200 ]

Font “X” is a MultipleMaster font ....................................................................................................................... [ 196 ]

Font “X” uses an artificial bold, italic or outline style ............................................................................................... [ 199 ]

Found objects with transparency settings ............................................................................................................. [ 194 ]

Halftone phases removed ................................................................................................................................ [ 190 ]

Image compression changed ............................................................................................................................ [ 215 ]

Image contains alternates that are default for printing ............................................................................................ [ 210 ]

Invisible object removed .................................................................................................................................[ 205 ]

Number of nodes <n> in the single path is more than 500 .......................................................................................[ 206 ]

Number of pages more than 1 ........................................................................................................................... [ 170 ]

Page <n> is empty ......................................................................................................................................... [ 170 ]

Process color – converted color ..........................................................................................................................[ 173 ]

Removed annotation .......................................................................................................................................[ 217 ]

Removed OPI ................................................................................................................................................ [ 216 ]

Renamed spot color .......................................................................................................................................[ 188 ]

Rendering intent removed ............................................................................................................................... [ 189 ]

Text does not knock out ..................................................................................................................................[ 205 ]
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List of Errors and Cautions in the Profile PDF/X-1a PLUS Commercial CMYK v1

Cautions

Changed Output Intent ................................................................................................................................... [ 227 ]

Custom black generation function removed .......................................................................................................... [ 193 ]

Custom undercolor removal function removed ....................................................................................................... [ 193 ]

Document encoding changed to binary ............................................................................................................... [ 158 ]

Font <font name> is a City font ......................................................................................................................... [ 198 ]

Font “X” is a TrueType font ............................................................................................................................... [ 195 ]

Font “X” is a Type 3 font .................................................................................................................................. [ 196 ]

Indexed color is used ..................................................................................................................................... [ 182 ]

Not all pages have the same orientation .............................................................................................................. [ 169 ]

Not all pages in the document have the same size .................................................................................................. [ 169 ]

Number of nodes <n> in the single path is more than 1000 ......................................................................................[ 206 ]

Number of pages more than 1 ........................................................................................................................... [ 170 ]

Page <n> is empty ......................................................................................................................................... [ 170 ]

PDF/X version key set to PDF/X-1a:2001 ................................................................................................................. [ 225 ]

Process color – converted color ..........................................................................................................................[ 173 ]
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Removed annotation .......................................................................................................................................[ 217 ]

Removed form fields, thumbnails, bookmarks, article threads or unused destinations ...................................................... [ 219 ]

Removed Object ............................................................................................................................................. [ 171 ]

Renamed spot color .......................................................................................................................................[ 188 ]

Text point size <n> is less than 5.00 ................................................................................................................... [ 201 ]

Text point size <n>, colored with 2 or more color plates, is less than 8.00 points ............................................................ [ 202 ]

Total ink coverage of flat CMYK is larger than <n> % ............................................................................................... [ 183 ]

Trapnet annotation does not conform to PDF/X-1a requirements ................................................................................. [ 223 ]

Errors

Alternative color space is not CMYK or Gray ........................................................................................................... [ 184 ]

Annotation lies inside printable area .................................................................................................................. [ 225 ]

Annotation setting changed to non-printing ......................................................................................................... [ 218 ]

Calibrated RGB is used .....................................................................................................................................[ 175 ]

Changed image resolution ................................................................................................................................[ 213 ]

Changed line width .......................................................................................................................................[ 206 ]

Changed Title, Producer or Creator to Unknown ..................................................................................................... [ 160 ]

Changed trapped flag to false ........................................................................................................................... [ 159 ]

Creation and/or Modification date info added ........................................................................................................[ 161 ]
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Custom transfer function removed ..................................................................................................................... [ 189 ]

Document contains actions .............................................................................................................................. [ 220 ]

Document has security .................................................................................................................................... [ 162 ]

Document needs repair on open ........................................................................................................................ [ 158 ]

Document Producer info string contains – Acrobat PDFWriter ......................................................................................[ 161 ]

Document uses <n> color separations instead of 0 ................................................................................................. [ 185 ]

Effective resolution of color or grayscale images is less than <n> dpi, or, Effective resolution of single-bit black & white images is less than
600 dpi ....................................................................................................................................................... [ 211 ]

Font "X" has been embedded .......................................................................................................................... [ 200 ]

Font <font name> is a double-byte font .............................................................................................................. [ 197 ]

Font “X” is a MultipleMaster font ....................................................................................................................... [ 196 ]

Font “X” uses an artificial bold, italic or outline style ............................................................................................... [ 199 ]

Found objects with transparency settings ............................................................................................................. [ 194 ]

Halftone phase is used .................................................................................................................................... [ 190 ]

ICC-based color is used ................................................................................................................................... [ 182 ]

Image compression changed ............................................................................................................................ [ 215 ]

Image contains alternates that are default for printing ............................................................................................ [ 210 ]

Lab is used .................................................................................................................................................. [ 178 ]

Page Box Layout does not match the Press Layout specifications ................................................................................. [ 164 ]
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PDF version is not equal to 1.3 ........................................................................................................................... [ 155 ]

Removed OPI ................................................................................................................................................ [ 216 ]

Rendering intent removed ............................................................................................................................... [ 189 ]

RGB color is used ........................................................................................................................................... [ 174 ]

Text does not knock out ..................................................................................................................................[ 205 ]
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[ List of Errors and Cautions by Category ] The Ultimate PDF/X Guide

143

List of Errors and Cautions by Category

Errors and Cautions of the Category “Document Format” .................................. [ 155 ]
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Errors and Cautions of the Category “Page Box Layout” .................................... [ 164 ]

Changed Page Box Layout to match the Press Layout specifications .....................[ 164 ]

Errors and Cautions of the Category “Page Size” ............................................. [ 169 ]

Not all pages in the document have the same size ........................................ [ 169 ]
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Errors and Cautions of the Category “Page Info” ............................................. [ 170 ]
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Number of pages more than 1 .................................................................. [ 170 ]
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Calibrated RGB is used ............................................................................[ 175 ]
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Indexed color is used ............................................................................ [ 182 ]
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Document contains ambiguously defined spot colors ..................................... [ 184 ]

Document uses <n> color separations instead of 0 ........................................ [ 185 ]

Spot color “X” and spot color “Y” have the same CMYK values........................... [ 187 ]

Spot color: converted color .....................................................................[ 188 ]

Renamed spot color..............................................................................[ 188 ]
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Errors and Cautions of the Category “Rendering Parameters” ............................. [ 189 ]
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Errors and Cautions of the Category “Transparency” ........................................ [ 194 ]

Found objects with transparency settings ................................................... [ 194 ]
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Errors and Cautions of the Category “Font Type” ............................................. [ 195 ]

Font “X” is a TrueType font ..................................................................... [ 195 ]

Font “X” is a Type 3 font......................................................................... [ 196 ]

Font “X” is a Multiple Master font ............................................................. [ 196 ]

Font <font name> is a double-byte font .................................................... [ 197 ]

Font <font name> is a City font................................................................ [ 198 ]
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Font "X" has been embedded................................................................. [ 200 ]
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Errors and Cautions of the Category “Text” .................................................... [ 201 ]

Text point size <n> is less than <n> ..........................................................[ 201 ]

Text point size <n>, colored with <n> or more color plates, is less than <n> points [ 202 ]

Black text is set to overprint.................................................................... [ 204 ]

Text does not knock out or white text has been set to knock-out ...................... [ 205 ]

Invisible object removed ....................................................................... [ 205 ]

Errors and Cautions of the Category “Line Art” ...............................................[ 206 ]

Changed line width ............................................................................. [ 206 ]

Number of nodes <n> in the single path is more than <n> ............................. [ 206 ]

Invisible object removed ........................................................................[ 207 ]

Errors and Cautions of the Category “Image Position” ......................................[ 208 ]

Image is rotated .................................................................................. [ 208 ]

X and Y scaling of image differ 3 % ........................................................... [ 209 ]
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Errors and Cautions of the Category “Image Resolution” ................................... [ 210 ]

Image contains alternates that are default for printing ................................... [ 210 ]

Removed alternate images ...................................................................... [ 211 ]

Effective resolution of images is less or larger than <n> dpi .............................. [ 211 ]

Changed image resolution .......................................................................[ 213 ]

Errors and Cautions of the Category “Image Compression” ................................ [ 215 ]

Image compression changed ................................................................... [ 215 ]
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Removed annotation .............................................................................[ 217 ]

Annotation setting changed to non-printing ............................................... [ 218 ]
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Errors and Cautions of the Category “Metadata” ............................................. [ 219 ]

Removed form fields, thumbnails, bookmarks, article threads or unused destinations....
[ 219 ]

Document contains actions .................................................................... [ 220 ]

Removed actions.................................................................................. [ 221 ]

Errors and Cautions of the Category “PDF/X” .................................................. [ 222 ]

Removed embedded PostScript fragment .................................................... [ 222 ]

Page description contains inline PS code ..................................................... [ 222 ]

Trapnet annotation does not conform to PDF/X-1a requirements ........................[ 223 ]

PDF/X version key set to PDF/X-1a:2001 ........................................................[ 225 ]

Annotation lies inside printable area .........................................................[ 225 ]

Moved objects outside of printable area......................................................[ 226 ]

Errors and Cautions of the Category “PDF/X Color” ........................................... [ 227 ]

Changed Output Intent........................................................................... [ 227 ]
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Alphabetical List of Errors and Cautions

Alternative color space is not CMYK or Gray .............................................................................................................. [ 184 ]

Annotation lies inside printable area ..................................................................................................................... [ 225 ]

Annotation setting changed to non-printing............................................................................................................ [ 218 ]

Black text is set to overprint ................................................................................................................................[ 204 ]

Calibrated RGB is used ........................................................................................................................................[ 175 ]

Changed image resolution ...................................................................................................................................[ 213 ]

Changed line width ..........................................................................................................................................[ 206 ]

Changed Output Intent ...................................................................................................................................... [ 227 ]

Changed Page Box Layout to match the Press Layout specifications ................................................................................. [ 164 ]

Changed Title, Producer or Creator to Unknown ........................................................................................................ [ 160 ]

Changed trapped flag to false .............................................................................................................................. [ 159 ]

Creation and/or Modification date info added............................................................................................................[ 161 ]

Custom black generation function removed ............................................................................................................. [ 193 ]

Custom halftone function is used .......................................................................................................................... [ 192 ]
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Custom undercolor removal function removed.......................................................................................................... [ 193 ]
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Document contains actions ................................................................................................................................. [ 220 ]

Document contains ambiguously defined spot colors .................................................................................................. [ 184 ]

Document encoding changed to binary .................................................................................................................. [ 158 ]

Document has security ....................................................................................................................................... [ 162 ]

Document needs repair on open........................................................................................................................... [ 158 ]

Document Producer info string contains: Acrobat PDFWriter ...........................................................................................[ 161 ]

Document uses <n> color separations instead of 0..................................................................................................... [ 185 ]

Effective resolution of images is less or larger than <n> dpi........................................................................................... [ 211 ]

Font "X" has been embedded ............................................................................................................................. [ 200 ]

Font <font name> is a City font ............................................................................................................................ [ 198 ]

Font <font name> is a double-byte font................................................................................................................. [ 197 ]

Font “X” is a Multiple Master font ......................................................................................................................... [ 196 ]

Font “X” is a TrueType font.................................................................................................................................. [ 195 ]

Font “X” is a Type 3 font ..................................................................................................................................... [ 196 ]

Font “X” uses an artificial bold, italic or outline style .................................................................................................. [ 199 ]

Found objects with transparency settings ................................................................................................................ [ 194 ]

Halftone phase is used....................................................................................................................................... [ 190 ]
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ICC-based color is used ...................................................................................................................................... [ 182 ]
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Image contains alternates that are default for printing................................................................................................ [ 210 ]

Image is rotated.............................................................................................................................................. [ 208 ]

Indexed color is used ........................................................................................................................................ [ 182 ]
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Moved objects outside of printable area.................................................................................................................. [ 226 ]

Not all pages have the same orientation ................................................................................................................. [ 169 ]

Not all pages in the document have the same size ..................................................................................................... [ 169 ]

Number of nodes <n> in the single path is more than <n>..........................................................................................[ 206 ]
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Page <n> is empty............................................................................................................................................ [ 170 ]

Page description contains inline PS code ................................................................................................................. [ 222 ]
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PDF/X version key set to PDF/X-1a:2001 .................................................................................................................... [ 225 ]
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Removed actions...............................................................................................................................................[ 221 ]
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Removed annotation..........................................................................................................................................[ 217 ]

Removed embedded PostScript fragment ................................................................................................................ [ 222 ]

Removed form fields, thumbnails, bookmarks, article threads or unused destinations......................................................... [ 219 ]

Removed object ................................................................................................................................................ [ 171 ]

Removed OPI................................................................................................................................................... [ 216 ]
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RGB color is used.............................................................................................................................................. [ 174 ]

Spot color “X” and spot color “Y” have the same CMYK values ....................................................................................... [ 187 ]
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Text does not knock out or white text has been set to knock-out ...................................................................................[ 205 ]

Text point size <n> is less than <n> ...................................................................................................................... [ 201 ]

Text point size <n>, colored with <n> or more color plates, is less than <n> points ............................................................ [ 202 ]

Total ink coverage of flat CMYK is larger than <n>% ................................................................................................... [ 183 ]

Trapnet annotation does not conform to PDF/X-1a requirements .................................................................................... [ 223 ]

X and Y scaling of image differ 3 % ........................................................................................................................[ 209 ]
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Errors and Cautions of the Category “Document Format”

PDF version is not equal to 1.3

Cause

The version numbers of the PDF files are different from those of Adobe Acrobat, as you can see in the illustration 
below.

If the PDF file version is lower than 1.3, it means that the 
PDF file is:

• created with Acrobat Distiller 3.x

• created with Acrobat Distiller 4.x or 5.x, but with the 
Job Information settings ensuring the compatibility with 
the 1.2 version.

The following table gives you an overview of the main differences between Acrobat 3.x (PDF 1.2) on one hand and 
Acrobat 4.x (PDF 1.3) and Acrobat 5.x (1.4) on the other.

Acrobat 3.0 (PDF 1.2) Acrobat 4.0 (PDF 1.3) and 5.0 (PDF 1.4)

PDF file can be opened by Acrobat viewers 3.0 and 
later.

PDF file can be opened by Acrobat viewers 3.0 and 
later. However, some or all of the documents may be 
unviewable if opened with versions earlier than the 
version used to create the file.
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See also Adobe Acrobat online Help.

Patterns display as 50% gray, but print correctly. Patterns display and print correctly.

Users can preserve, remove or apply Transfer func-
tions.

Users can preserve or remove Transfer functions in 4.0 
but not apply them. Users can preserve, remove or 
apply Transfer functions in 5.0.

All colors are converted to CalRGB. All colors are converted to sRGB.

ICC profile color management is not supported. ICC profile color management is supported.

DeviceN color space is converted to alternate color 
space.

DeviceN color space is supported.

Smooth shaded objects are converted to images. Smooth shading is supported.

Acrobat 3.0 (PDF 1.2) Acrobat 4.0 (PDF 1.3) and 5.0 (PDF 1.4)
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Solution

Create a new PDF document and make sure that the PDF 
version is 1.3. You can do this in the following ways:

• Use Acrobat Distiller 4.x to convert your PostScript file into 
a PDF document.

• Use Acrobat Distiller 5.x to create a PDF document but 
make sure that the option Compatibility in the General Job 
Options is set to Acrobat 4.0 (PDF 1.3), as shown in the 
example.

• If the PDF version of your PDF document is earlier than 1.3, 
open your PDF document in Adobe Acrobat 4.0 and save it 
again. 
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Document encoding changed to binary

Cause

The PDF file contains ASCII-encoded elements. ASCII encoding was formerly required to ensure that PDF files could 
be safely transported via e-mail or the Internet. However, most e-mail software in use today deals with 
non-ASCII documents normally, which eliminates the need to ASCII-encode your document. The increase in file 
size when you use ASCII encoding is substantial.

Solution

All ASCII encoding will be removed and the PDF document will be converted automatically to a binary format, 
which can significantly reduce the file size. Note that the size of some files could increase slightly.

Document needs repair on open

Cause

There are several ways in which a PDF document can be damaged, and this check enables you to find out whether 
the document has incurred such damage. Possible sources of PDF damage are incomplete downloading from the 
Internet, mailing a binary-encoded PDF with an ASCII mail system, etc. Adobe Acrobat automatically detects such 
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damage, and attempts to repair it when the PDF document is opened. In this repair process, the document's 
index file is regenerated. However, these repairs may not suffice if you plan to use the file in your online work-
flow, although the damage may go unnoticed in documents that are used in print environments only.

Solution

Redistill your PDF document or save it in Adobe Acrobat. Choose File > Save as and save your file with the same 
name.

Changed trapped flag to false

Cause

The trap flag for the PDF document was set to trapped or unknown.

Solution

The trap flag has been set to false, i.e. “not trapped”. 
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Errors and Cautions of the Category “Document Info”

Changed Title, Producer or Creator to Unknown

Meaning

When viewing a PDF document, you can view some basic informa-
tion on the file, such as the title, the author, the subject of the 
document, etc. In Acrobat 5, for example, you can do so by 
choosing File > Document Properties > Summary. Some of this 
information is set by the person who created the PDF document, 
some by Acrobat. The Creator field, e.g., shows the authoring 
application in which the original document was created (e.g., 
Adobe FrameMaker, Microsoft Word, etc.).

In some cases, however, the Title, Producer or Creator text field 
can be empty. If so, the PDF/X-1a profile will fill in the word 
“Unknown” in the corresponding text field.



[ Errors and Cautions of the Category “Document Info” ] The Ultimate PDF/X Guide

161

Creation and/or Modification date info added

Meaning

When viewing a PDF document, you can view some basic information on the file, such as the creation date, 
modification date, file size etc. In Acrobat 5, for example, you can do so by choosing File > Document 
Properties > Summary. Some of this information, such as the creation date and modification date, is normally 
filled in automatically at the time when the PDF document is created. Sometimes, however, it is not. If the 
creation date or the modification date is missing, the PDF/X-1a profile will fill in the current date instead.

Document Producer info string contains: Acrobat PDFWriter

Cause

The PDF file has been created with the Acrobat PDFWriter printer driver.

Solution

Use Acrobat PDFWriter only if you want to convert small text documents without graphics into a PDF format. For 
files with a lot of graphics, colors and different fonts, use the Acrobat Distiller printer driver.
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Errors and Cautions of the Category “Security”

Document has security

Cause

You can provide the PDF documents with security. You can use a password to restrict the access to certain features 
such as:

• Printing the PDF documents

• Changing the PDF document

• Selecting text and graphics

• Adding notes to the PDF document

Solution

Save your PDF document without any security.

In Acrobat 5, proceed as follows:

1 Open the PDF document.

2 Choose File > Document Security.

3 Choose Acrobat Standard Security and click Change Settings.
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4 Type the password and click OK.

5 Click to clear the selected security settings and click OK.

6 Click Close.

7 Save and close your PDF document.

In Acrobat 4, proceed as follows:

1 Open the PDF document.

2 Choose File > Save as.

3 Click Settings in the Security window. 

4 Type the password, click to clear all the security settings and click OK.

5 Click Save.
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Errors and Cautions of the Category “Page Box Layout”

Changed Page Box Layout to match the Press Layout specifications

Cause

When you design a document and create a PDF document, it will contain a number of page boxes. Page boxes 
are imaginary rectangles drawn around the various objects in the page and around the page itself. You cannot 
see these page boxes if you look at a PDF document in Adobe Acrobat without one of the supported PDF/X editing 
tools. They are a sort of description “behind the scenes” of the layout of your PDF document. See also “Types of 
page boxes” on page 167.
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There are instances in the PDF document where the page box layout 
does not conform with the press layout. The press layout was set in 
the PDF/X-1a profiles as follows:

• 5 mm between the media box and the bleed box

• 5 mm between the bleed box and the trim box

If you do not follow this rule, you receive a warning in the report. 
Examples of this sort of variations are:

• The bleed box and the trim box are not set in the source docu-
ment, which seems to make them coincide with the media box. In 
this case, you can have problems with the printing because the trim 
box is too big or not present.

• A trim box was set but it is a box of 3 mm, which is less than the 
5 mm required from the profile. In this case, a variation from the 
profile is recommended so that the file can be printed correctly.
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Solution

Because the PDF documents come from different programs, 
there are different possibilities that do not necessarily cause 
problems. If this warning appears in the report, a visual check 
is the only solution. In Adobe Acrobat, you can see the 
different boxes thanks to this button  (View page boxes) of 
Enfocus PitStop Professional. If you want to see or to change 
the coordinates of the different page boxes, use Enfocus 
PitStop Professional or one of the other supported tools, and 
proceed as follows:

1 Choose Window > Show PitStop Global Change.

2 Click the Page tab > Page boxes.

3 Change the coordinates of the page box.

4 Click Apply.
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Types of page boxes

The illustration below shows the various types of page boxes.

A. Media box The media box is the largest page box. The media box 
corresponds to the page size (e.g. A4, A5, US Letter etc.) that you 
selected when you printed your document to a PostScript or PDF 
file. In other words, the media box determines the physical size of 
the media on which the PDF document is displayed or printed.

B. Bleed box If you use bleed in your document, the PDF document 
will also have a bleed box. Bleed is the amount of color (or any 
other artwork) that extends beyond the edge of a page. You can 
use bleed to make sure that, when the document is printed, the 
ink will be printed to the edge of the page.

C. Trim box The trim box indicates the final size of a document 
after printing and trimming.

D. Art box The art box is the box drawn around the actual contents 
of the pages in your documents. This page box is used when 
importing PDF documents in other applications.

Crop box The crop box is the “page” size at which your PDF docu-
ment is displayed in Adobe Acrobat. In normal view, only the 
contents of the crop box are displayed in Adobe Acrobat.

Airborne B

A

C

D
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Use of page boxes

Page boxes are particularly useful to resize objects or pages in your PDF document. There are a number of soft-
ware solutions that offer you the tools to do this by means of global changes or PDF Profiles. Thus, you can easily 
resize your document from A4 size to US Letter or to a custom page size, for example, without having to make 
—often cumbersome and time-consuming— modifications in your source document.

Pages boxes: example

Suppose you create a cover for a magazine in the following steps:

1 You decide that the size of the cover after printing and trimming will be A5 (148 x 210 mm). This will be the 
size of the trim box.

2 You are also using a background color which extends to the left, right and bottom edge of the page. To this 
end, you use 5 mm of bleed on either side. Consequently, the size of the bleed box will be 158 x 220 mm.

3 You place this artwork on a blank page in a desktop publishing program. The size of the blank page is 180 x 
260 mm. This will become the crop box in Adobe Acrobat.

4 Finally, you print this file to a PostScript file (and create a PDF document of it later). When selecting a printer 
driver, you specify that the page size has to be A4 (210 x 297 mm), because printer and registration marks have 
to fit on the page. This will be the size of the media box.
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Errors and Cautions of the Category “Page Size”

Not all pages in the document have the same size

Cause

The PDF file contains pages of different sizes.

Solution

Create a separate page file per page size. Now you can extract the pages with a different size and save them 
separately. To extract a page, use the Acrobat Document command > Extract Pages and choose Delete Pages After 
Extracting.

Not all pages have the same orientation

Meaning

A single PDF document can contain both portrait and landscape pages. If so, a caution may appear in the 
preflight report. Check your PDF document to make sure that pages have not been rotated inadvertently.
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Errors and Cautions of the Category “Page Info”

Page <n> is empty

Cause

The document contains an empty page. This was maybe done intentionally, e.g. if a chapter ends on an empty 
even page.

Solution

Delete the empty page in Adobe Acrobat (click Document and Delete Pages) and check if the page numbers are 
still consistent. If this is not so, delete the empty page(s) in the source document and create the PDF file again.

Number of pages more than 1

Cause

This error may appear in the profile PDF/X-1a PLUS Newspapers v2 because, obviously the PDF document may only 
consist of 1 page.
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Solution

Check your original document and make sure it only consists of 1 page.

Removed object

Meaning

The PDF document contained one or more graphic elements that lay completely outside the media box. The 
media box corresponds to the page size (e.g. A4, A5, US Letter etc.) that you selected when you printed your 
document to a PostScript or PDF file. In other words, the media box determines the physical size of the media 
on which the PDF document is displayed or printed.

See also “Types of page boxes” on page 167.
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Cause

A possible cause is that the size of the media box of the PDF document was 
changed later, using PDF editing software. For example, suppose you had 
an A4-size PDF document with printer registration marks and the media box 
of this PDF document was changed to US letter later. The contents of the PDF 
document, however, was not scaled or moved correspondingly. In that case, 
the top and bottom trim or registration marks may lie outside the media 
box.

Solution

Objects outside the media box will be removed automatically by the PDF/X 
profile.

Graphic object
outside media box

US letter
(8,5 x 11 inch)

A4
(210 x 297 mm)
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Errors and Cautions of the Category “Process Color”

Process color: converted color

Meaning

The PDF/X has detected text or line art which had inappropriate color definitions. If so, these colors will auto-
matically be converted, as listed in the table below.

Color definition Converted to

RGB CMYK

Calibrated Gray CMYK

Calibrated RGB CMYK

Lab CMYK

ICC based colors CMYK

RGB gray Gray space gray

CMYK gray Gray space gray

RGB black Gray space black
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For more information about color management and color models, see the respective chapter in your PDF/X soft-
ware solution User Guide.

RGB color is used

Cause

Some of the object in the PDF document contain RGB colors. An object can be a text, line art or a pixel image. 
RGB colors have to be converted according to the appropriate color model.

Solution

You can proceed as follows:

• Convert the text or line art in the appropriate color model. You can do this in Adobe Acrobat via Enfocus PitStop 
Professional, with for example the Enfocus PitStop Inspector, a global change or an Action List; or with one of 
the many other software solutions mentioned in this guide.

• Convert the pixel file according to the appropriate color model. To do this, activate Adobe Photoshop, select 
Image and click Mode and CMYK Color. Import the file again in the design program (or update the link to that 
file) and create the PDF file again.

CMYK black Gray space black

Color definition Converted to
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Calibrated RGB is used

Cause

This check enables you to identify all the occurrences of calibrated gray or calibrated RGB.

The reproduction of a color or a grayscale slightly differs from an input device (e.g., a scanner or a digital camera) 
to an output device (e.g., a computer screen). That is why the colors on screen can be different from the colors 
produced when you print the PDF on an output device. To prevent this, calibrated colors contain information on 
how each device (e.g., a color screen) compensates its standard settings in order to faithfully reproduce colors. 
For example, the calibrated color mentions that screen X has to add 5% of red to obtain the intended color. Note: 
calibrated colors are only useful when they apply to a totally calibrated workflow. In this case, the input and 
output devices of the workflow as well as the display screen of the document are calibrated.

Solution

Check your source files and look for occurrences of calibrated gray or calibrated RGB color definitions. Replace 
the calibrated gray or the calibrated RGB by a CMYK color or a spot color.

If you have one of the many PDF/X solutions introduced in this guide, it is easier to correct this error directly in 
the PDF document.
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Proceed as follows:

1 Click the cross sign (✗ ) in the report.

The Enfocus PitStop Navigator Panel appears and 
the first object in calibrated gray or in calibrated 
RGB is visible.
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2 Choose Window > Show PitStop Inspector and 
check the calibrated gray or calibrated RGB values.

3 Choose Window > Show PitStop Global Change.

4 In the Object > Color tab, in the From area, click 
Grab fill.

Tip: Also check the color management settings in 
Enfocus PitStop Professional or one of the other 
solutions. For more information, read the 
following chapters in the User Guide:

• "Setting Your Enfocus PitStop Professional Pref-
erences"

and

• "Chapter 11: Color Management"
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5 In the “To” area, select the color you want to 
change the calibrated gray or the calibrated RGB 
to. This can be done in different ways:

• Click Load and load a color from the repository.

• In the PDF document, click an object with the 
right color and then click Grab Fill in the Global 
Change panel.

• Specify the CMYK values and click Save to reuse 
this color later on.

6 Click Apply.

7 Do one of the following:

• Select Apply to > Complete Document and click 
Apply to carry on this change in the complete PDF 
document.

• Click Save as Action List if you still have other PDF 
containing this specific calibrated color. 

Lab is used

Cause

This check enables you to identify all the occurrences of LAB colors.
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The LAB color space (CIE) is a device-independent color space. It is used as a reference point by the color manage-
ment systems. If LAB colors are used as a reference, the color management system can compare the color gamuts 
from the devices. The LAB color space is broad enough to contain all the colors viewable to the human eye.

For more information on the color gamuts and the color spaces, read the Enfocus PitStop Professional User Guide, 
or consult one of the many other industry-wide resources available.

Solution

Check your source files and look for LAB colors. Replace them by a CMYK color or a spot color. 

If you have Enfocus PitStop Professional, or one of the other software solutions, it is easier to correct this error 
directly in the PDF document.

Proceed as follows:

1 Click the cross sign (✗ ) in the report.

The Enfocus PitStop Navigator Panel appears and 
the first object in a LAB color is visible.
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2 Choose Window > Show PitStop Inspector and 
check the LAB color values.

3 Choose Window > Show PitStop Global Change.

4 In the Object tab > Color, in the “From” area, 
click Grab Fill.

Tip: Also check the color management settings in 
Enfocus PitStop Professional. For more information, 
read the following chapters in the User Guide:

• "Setting Your Enfocus PitStop Professional Pref-
erences"

and

• "Chapter 11: Color Management"
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5 In the “To” area, select the color you want to 
change the LAB color to. This is possible in different 
ways:

• Click Load and load a color from the repository.

• In the PDF document, click an object that has 
the right color and then click Grab Fill in the Global 
Change panel.

• Specify the CMYK colors and click Save in order to 
reuse this color later on.

6 Click Apply.

7 Do one of the following:

• Select Apply to > Complete Document and click 
Apply to carry on this change in the entire PDF 
document.

• Click Save as Action List if you still have other PDF 
documents containing this specific LAB color.
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ICC-based color is used

This check detects all occurrences of ICC profile based colors. Every input and output device reproduces color and 
grayscales in a slightly different way. As a result, the colors you see in a PDF file on your screen may not match 
the colors produced when you print the PDF to an output device. Several options are available to avoid this 
problem of device dependency, one of which is using ICC color profiles. 

An ICC color profile is a mathematical description of the color space used by a specific device. In other words, the 
ICC color profile describes how the colors produced by the device relate to the reference CIE LAB color space (a 
device-independent color space). 

Indexed color is used

Cause

The indexed color space uses no more than 256 colors, and is as such particularly suited for use in Web applica-
tions. Images are typically converted to indexed color mode in order to decrease their file sizes. When an image 
is converted to indexed color, a color lookup table is created, in which the colors that were used in the image 
are stored and indexed. Using an indexed color table lets you reduce the file size of an image while maintaining 
the visual quality that you need.

Solution

Avoid using indexed colors in your source documents. Use CMYK colors instead.
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Total ink coverage of flat CMYK is larger than <n>%

Cause

The combination of the four components of the CMYK color you used gives an ink coverage higher than a given 
maximum allowed percentage, e.g. 310 %.

Solution

Reduce the total ink coverage of the four CMYK inks to less than 
the percentage mentioned in the preflight report. You can do 
this in your design program or use one of the Acrobat plug-in 
solutions.
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Errors and Cautions of the Category “Spot Color”

Alternative color space is not CMYK or Gray

Cause

This check allows you to check the PDF document for the presence of spot colors with an alternative color space 
definition other than CMYK or Gray.

Solution

The alternative color space for the offending spot color is automatically converted to CMYK.

Document contains ambiguously defined spot colors

Cause

When two spot colors with the same name and different CMYK values are found in the document, they are 
considered ambiguously defined spot colors.

For example, when you have integrated a graphic in a spot color from a drawing program in a DTP program in 
which you also used this spot color but with different CMYK values. 
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With this check, you can find out whether any ambiguous spot color definitions are present in the PDF document. 
The risk of these ambiguous definitions lies in the fact that these spot colors will appear as differing colors on 
screen or when printed with process colors, but they will print as one and the same color when printed with spot 
color inks.

Solution

Check your source files and make sure the spot color values are the same everywhere, also in imported line 
graphics. 

If you have Enfocus PitStop Professional, it is easier to correct this error and to manage your spot colors with the 
color repository.

For more information, see the chapter on “Working with a Color Repository” in the User Guide of Enfocus PitStop 
Professional.

Document uses <n> color separations instead of 0

Cause

In offset printing, each CMYK color (cyan, magenta, yellow, black) is reproduced using a single printing plate. The 
document colors must be separated when used for offset printing. One color is used for each plate. Then each 
plate is printed making sure the registration marks match exactly. This way, the four inks combine to produce 
the original drawing.
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The PDF Profile checks the number of separations in the PDF document by comparing them with the number you 
chose. This does not take into account:

• The basic selection of the process colors cyan, magenta, yellow and black.

• The spot color “All” used for the registration marks. The spot color “All” is the “registration color”.

The settings depend on your verification of the PDF document: you can check its ability to print in CMYK or in spot 
colors. The following table gives you an overview of the settings and their meanings.

Profile for... Setting Meaning

CMYK The number of separations — except CMYK— 
must be equal to 0. If this is not the case, an 
error will occur in the report, saying there are 
more colors than cyan, magenta, yellow and 
black.

Spot color One or more spot colors will be used. In other 
terms, there must be more separations than 0. 
If this is the case, a “warning” will inform you 
in the report.
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Solution

Check the source document and look for CMYK colors and spot colors. 

If you have Enfocus PitStop Professional, you can apply a global change. If you have to perform this color change 
in several PDF documents, you can save this global color change as an action list. 

For more information, see the Enfocus PitStop Professional User Guide.

Spot color “X” and spot color “Y” have the same CMYK values

Cause

If two spot colors with the same CMYK values but different names are found in the document, they are considered 
ambiguously defined spot colors.

With this check, you can find out whether any ambiguous spot color definitions are present in the PDF document. 
The danger of these ambiguous definitions lies in the fact that these spot colors will appear as differing colors 
on screen or when printed with process colors, but they will print as one and the same color when printed with 
spot color inks.

Solution

Check your source files and the CMYK values of the spot colors, also in imported line graphics. Delete the super-
fluous spot colors.

If you have Enfocus PitStop Professional, it is easier to correct this error and to manage your spot colors with the 
color repository. For more information, see the chapter “Working with the Color Repository” in the User Guide of 
Enfocus PitStop Professional.
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Spot color: converted color

Meaning

Spot colors were used in your PDF document and they have been converted to CMYK colors.

Spot colors are printed with special premixed inks, used instead of, or in addition to, CMYK inks (process colors). 
Spot color printing requires a separate plate for every spot color, whereas process color printing only uses four 
plates, one for each of the four basic CMYK colors. Spot colors are especially well suited for offset printing, but 
should be used with caution when creating documents for digital output or monitor display. Note that spot colors 
are also more expensive to print.

Renamed spot color

Cause

The PDF document contains two spot colors with names that differ only in their suffixes, e.g. Rubine Red CV and 
Rubine Red CVU. This kind of conflict should be avoided.

Solution

Al the suffixes in conflict by CV, CVU or CVC are automatically replaced by CV.
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Errors and Cautions of the Category “Rendering Parameters”

Custom transfer function removed

Meaning

Custom-designed transfer curves are used for objects in the PDF document. A transfer curve is used to change 
the colors in a document in a uniform way. For example, you can define transfer curves that invert all the colors 
for line art in the document, increase the saturation for all colors in the document, etc. 

Custom transfer curves are removed automatically by the PDF/X profile.

Rendering intent removed

Meaning

A rendering intent is a translation method used to convert colors between different devices. Each output device 
has a different color range that it can reproduce. In order to conserve the appearance of an image across devices, 
the colors that cannot be reproduced by a specific output device (i.e. your color printer) need to be remapped to 
the nearest matching color that does lie within the output device's color range. 
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This remapping is performed according to a specific method called a rendering intent. In addition, rendering 
intents can also be defined to deal with different types of graphics, to achieve the best possible results for a 
particular type of image, on a particular output device.

Rendering intents were used in the PDF document and were automatically removed by the PDF/X-1a profile.

Halftone phases removed

Meaning

Halftone phases were used in the PDF document and have automatically been removed by the PDF/X-1a profile.

A halftone phase is a shift in the alignment of halftone and pattern cells in device space, to compensate for 
window system operations that involve scrolling. Halftone phases are no longer used, but may still be found in 
documents containing artwork from older source applications (e.g. CorelDraw 7).

Halftone phase is used

Cause

A halftone phase is a shift in the alignment of halftone and pattern cells in device space, to compensate for 
window system operations that involve scrolling. It is no longer used, but may still be found in documents 
containing artwork from older source applications (e.g. CorelDraw 7).
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Solution

Remove artwork containing halftone phase information from the source documents.

Custom halftone function removed

Meaning

Custom-designed halftone transfer curves were used in the PDF document and have automatically been removed 
by the PDF/X-1a profile.

A halftone transfer curve is used to compensate for the dot gain or dot loss that occurs when an image is trans-
ferred to film. Also, halftone transfer curves are used when transferring the document to film in order to make 
up for the dot gain or loss associated with a specific printing device. Dot gain is the phenomenon that occurs 
when a dot (the smallest printed unit) is transferred to film, or printed on paper. The size of the dot may increase 
or decrease (dot loss) slightly as a result of either of these processes.



[ Custom halftone function is used ]The Ultimate PDF/X Guide

192

Custom halftone function is used

Cause

A halftone transfer curve is used to compensate for the dot gain or dot loss that occurs when an image is trans-
ferred to film. Also, halftone transfer curves are used when transferring the document to film in order to make 
up for the dot gain or loss associated with a specific printing device. Dot gain is the phenomenon that occurs 
when a dot (the smallest printed unit) is transferred to film, or printed on paper. The size of the dot may increase 
or decrease (dot loss) slightly as a result of either of these processes.

Solution

Remove the custom halftone function from the source documents. To do this, make sure that the Print Setup in 
the source application does not include any custom halftone screening, but leaves this to the printer. For 
example, in QuarkXPress:

1 Click File > Print.

2 Click the Output tab in the Print dialog box.

3 Choose Printer from the Halftone list.
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Custom undercolor removal function removed

Meaning

Custom undercolor removal definitions (UCR) have been included in the PDF document.

Undercolor removal is the process of removing large percentages of cyan (C), magenta (M), and yellow (Y) ink prior 
to printing, and replacing them with black (K) ink, in order to achieve a clearer black color in print, and to save 
on color inks.

Custom black generation function removed

Meaning

Black generation curves (BG) have been used for objects in the PDF document.

Black generation (BG) is the process of adding black ink to CMY-generated black and gray, in order to achieve a 
clear black color and to save valuable color ink.
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Errors and Cautions of the Category “Transparency”

Found objects with transparency settings

Cause

The PDF document contains transparent objects. This can cause some problems if the document is visualized in 
Adobe Acrobat 4.0: transparent objects can indeed be rendered correctly in earlier versions. A transparent layer 
can also cause problems when you transpose the PostScript code of your PDF document to the halftone informa-
tion of your printer (the “ripping”).

A typical example occurs when you save graphics with transparent elements as PDF compatible with Acrobat 5.0 
in Adobe Illustrator 9.0 or Adobe InDesign 2.0. In Adobe Acrobat 4.0 transparent objects are made opaque in 
your documents. That is why the profile checks if your documents contain transparent objects.

Solution

You have to make the transparent objects opaque. This is possible in different ways: 

• You can save the graphics in your source documents compatible with Adobe Acrobat 4.0.

• You can render the transparent objects manually opaque with the PitStop Inspector. Select the object and 
choose Show PitStop Inspector > Prepress > Transparency.

• You can render the transparent objects with an Action List. Choose Show PitStop Action List Panel and create 
an Action List to render the transparent objects opaque (Add > Changes > Remove Transparency).



[ Errors and Cautions of the Category “Font Type” ] The Ultimate PDF/X Guide

195

Errors and Cautions of the Category “Font Type”

Font “X” is a TrueType font

Cause

The specified font is a TrueType font.

Solution

The TrueType fonts are widely used and are integrated in almost all desktop office software applications for the 
Windows and Mac operating systems. However, some professional prepress service providers are reluctant to 
support TrueType fonts, because they need to be converted to PostScript outlines in order to print well on Post-
Script devices, which may affect the quality of the resulting font. 

Replace in your design program or word processor the TrueType fonts by their equivalent in the Adobe Type 1 
format. Example: replace Arial (TrueType) by Helvetica (Adobe Type 1) or Times New Roman (TrueType) by Times 
(Adobe Type 1).
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Font “X” is a Type 3 font

Cause

The specified font is an Adobe Type 3 font.

Solution

The Adobe Type 3 fonts are special mostly ornamental fonts with complex shapes and fills. They sometimes cause 
printing problems.

Select another font in your design program or word processor, such as Adobe Type 1, or convert the font to vector 
outlines and create the PDF file again. For more information on vector outlines, see the chapter on “Converting 
text to outlines” on page 105.

Font “X” is a Multiple Master font

Cause

The specified font is a Multiple Master font.
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Solution

Multiple Master fonts are an extension of the Type 1 font format. Their particularity is that you can use e.g. Adobe 
Type Manager to create variants of a standard font (Master). You can recognize a Multiple Master font by the 
double “M” in its name; e.g.: TektoMM_308_wt_564_wd. Replace in your design program or word processor the 
Multiple Master fonts by fonts in the Adobe Type 1 format or convert the font in vectors and create the PDF file 
again.

Font <font name> is a double-byte font

Cause

The specific font is a composite font (also called a “double-byte” font). Composite fonts enable you to display 
Asian characters. They are also called “double-byte” fonts because every character is determined by 2 bytes (16 
bits). Asian characters are not always supported in a later stage of the PDF workflow. 

Solution

Convert the composite font to outlines in your design program or in your word processor, and create the PDF file 
again.
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Font <font name> is a City font

Meaning

Fonts of the type “City” are used in the PDF document. City fonts are characterized by their name: these are city 
names like Geneva and Chicago. The City fonts are derived from bitmap fonts. On the Mac OS, they are sometimes 
used as substitution fonts when a specific font is not found on the system.

If a City font is found in the PDF document, it is mentioned in the report as a “Warning”. It is not necessary a 
problem, but it is not recommended to use this kind of fonts.
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Errors and Cautions of the Category “Font Style”

Font “X” uses an artificial bold, italic or outline style

Cause

Some fonts have only one standard size and one style: Roman. If you want to use another style, you will have 
to choose a similar font. Let’s take the example of Futura: to put the written text in this font in italics or in bold, 
you will have to use Futura-Oblique or Futura-Bold, respectively.

Certain design programs or word processors allow you to adapt the style or the size of these fonts artificially. You 
only have to select the text and to put it in italics or in bold via the respective shortcuts. This method can seem 
very handy but it is recommended to avoid it because of the lesser quality of these artificial styles.

Solution

Replace the font by its respective “Bold”, “Italic” or “Outline” variant. You can do this in your design program 
or word processor and then create your PDF file again, or do it directly in the PDF document with one of the 
Acrobat plug-in solutions:

• Interactively with Enfocus PitStop Inspector: select the text with Edit Paragraph  of Enfocus. Click Window 
and Show PitStop Inspector and select, in the Text tab, another font by clicking on the Fonts button.

• In the entire document with a global change or an action list.
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Errors and Cautions of the Category “Font Embedding”

Font "X" has been embedded

Meaning

Embedding fonts in a PDF document means that every char-
acter of this font is copied and stored in the PDF document. 
This is useful if you create PDF documents to be displayed on 
different systems and to be printed on different devices: 
these are often system that do not contain exactly the same 
fonts. If a font is embedded in a PDF document, you will 
always be able to edit this text in this font, even though the 
font is not installed on your computer.

When you create new PDF files, make sure that you embed 
all the used fonts. You can do this as follows in Acrobat 
Distiller:

1 Choose Settings > Job Options.

2 Click the Fonts tab.

3 Select Embed All Fonts and add all the required fonts in 
the Always Embed list



[ Errors and Cautions of the Category “Text” ] The Ultimate PDF/X Guide

201

Errors and Cautions of the Category “Text”

Text point size <n> is less than <n>

Cause

Some text is smaller than the minimum required point size defined in the PDF/X profile. This problem can be 
caused by the following:

• An illustration containing text of a small point size (e.g.: 10 pt) was inserted in a DTP program and then scaled 
down (e.g.: 70%).

• A font which is too small may have been used in the DTP program itself.

Some PDF/X profiles contain a second preflight check that looks for text that is smaller than a given point size 
when using a given number of separations. See “Text point size <n>, colored with <n> or more color plates, is 
less than <n> points” on page 202.
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Solution

You can increase the text size in Adobe Acrobat (using one of the many 
PDF editing solutions introduced in this guide), or in your word 
processor, design or drawing program.

In Enfocus PitStop Professional, proceed as follows:

1 Select the text that is too small.

2 Choose Window > Show PitStop Inspector.

3 Display the Text tab.

4 Specify the new text size in the Size field.

Text point size <n>, colored with <n> or more color plates, is less than <n> points

Cause

Some text has been found in the PDF document that:

• Occurs on a given number of color separations and

• Is smaller than a given point size

If small text occurs on several color separations, the readability can become limited. The slightest mistake in the 
alignment of the printing plates causes printing problems as shown in the illustration.
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The plates are correctly aligned on the left. On the right, a slight anomaly is 
visible. The text is thus less readable. When using small text, even the 
smallest anomalies sometimes unavoidable when aligning the plates 
become visible.

Solution

Make sure that the text that occurs on different color separations is larger than the minimum required point size 
mentioned in the preflight report. You can increase the text size in your PDF document in several ways:

• You can change the size in the source files and create a new PDF document.

• You can change the size in the text with PitStop Inspector. Choose Window > Show PitStop Inspector > Text.

• You can make a global change to maximize the text size. Choose Show PitStop Global Change > Font.

• You can create an Action List. Choose Show PitStop Action List Panel and create an Action List that will give the 
text a size of at least 6 pt.

TeTeTeTe
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Black text is set to overprint

Meaning

Text —especially fine text or text set at a small point size— on 
colored backgrounds is extremely difficult to print in register. The 
slightest misregistration can become noticeable as small gaps can 
appear between the text and the underlying colored elements. 

To avoid this problem, black text is set to print on top of any 
colored backgrounds. This technique is known as overprinting. 
Overprinting preserves the legibility of the text.

Overprinting black text compensates for misregistration.

You can specify overprinting only for 100% black text because 
printing text of any color other than solid black over any other 
colored background might cause the overlapping inks to blend, 
which could produce undesirable colors.

Writing
   modular
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Text does not knock out or white text has been set to knock-out

Cause

The PDF document contains white text that does not knock out. If your document contains white text, you have 
to make sure that the colors behind the text are not printed. This is called knock-out printing: the white text 
should knock out the colors on the other separations. The profile checks if the PDF document contains any white 
text that would not be printed this way.

Solution

If the error “Text does not knock-out” appears in the preflight report, check the knock-out and overprint-related 
color definition settings in your DTP software package.

The PDF Profile PDF/X-1a PLUS Commercial CMYK v1 will fix this problem automatically and the report will show 
the error message “White text has been set to knock-out”.

Invisible object removed

Meaning

Invisible text has been detected in the PDF document and the PDF/X-1a profile has removed it automatically. 
Invisible text is text that has no fill or stroke color.
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Errors and Cautions of the Category “Line Art”

Changed line width

Meaning

Lines have been detected in the PDF document with a stroke weight of less than a given point size. Depending 
on the resolution of the output device on which the document is printed, lines thinner than this point size may 
disappear in the output document.

The line weight has automatically been increased to the minimum required point.

Number of nodes <n> in the single path is more than <n>

Cause

The number of anchor points inside a path is higher than the maximum number allowed. This often happens 
when you automate the clipping of bitmaps or their conversion to line art. This can result in an error of the type 
“Limitcheck” on the RIP: the path is too complex to be handled.
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Solution

Create the line art again manually or simplify it. Adobe Illustrator, for example, enables you to split line art, so 
that the components contain less anchor points. Some design programs can also simplify line art.

Invisible object removed

Meaning

An invisible object is line art the lines of which do not have any stroke weight or color. These line-art objects 
have been removed automatically by the PDF/X-1a profile.
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Errors and Cautions of the Category “Image Position”

Image is rotated

Meaning

Pixel images in the PDF document have been rotated slightly:

• over an angle that is not a multiple of 90°

• over an angle that deviates less than 3°.

The purpose of this check is to detect pixel images which may have been rotated by accident. For example, if you 
had a Rotate tool selected and click in the image by accident, you may have rotated the image slightly without 
even noticing it. 
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X and Y scaling of image differ 3 %

Cause

An image in your PDF document has been scaled non-proportionally. The scaling percentages along both the X- 
and the Y-axis are not equal. There is a difference of more than 5 % between these 2 values. The proportions 
between height and length of the image are changed, resulting in distortions in the image, e.g. squares have 
become rectangles.

Solution

If non-proportionally scaled images are necessary, you can create them in an image editing software or in a 
drawing program and insert them again in the design program. Create the PDF file again. 
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Errors and Cautions of the Category “Image Resolution”

Image contains alternates that are default for printing

Cause

Alternate images are used to store both a viewing-resolution and a printing-resolution version an image in a 
single PDF document. Usually, the main image has the label “default for printing”, but it is also possible for one 
of the alternates to carry this label. In this scenario, Acrobat uses the main image for on-screen display, but 
prints the alternate.

Not all software is capable of handling alternate images that are the default for printing. Such software always 
prints the main image, regardless of the labelling of the alternate images. This is why the PDF/X standard does 
not allow alternate images to be the default for printing.

Solution

In your design or editing software, do one of the following:

• Remove the alternate image that has been set as the default for printing.

• Set the main image as the default for printing.
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Removed alternate images

Meaning

Alternate images can be used to store both a viewing-resolution and printing-resolution version of an image. 
These alternate images have been removed automatically by the PDF/X-1a profile.

Effective resolution of images is less or larger than <n> dpi

Cause

The resolution of color, grayscale or black-and-white images is too high or too low, depending on the allowed 
maximum or minimum values in the PDF/X profile. The table below lists the required minimum and allowed 
maximum values for color, grayscale or black-and-white images per profile.

Image type Resolution PDF/X-1a:2001 
v2

PDF/X-1a PLUS 
Magazines v2

PDF/X-1a PLUS 
Newspapers v2

PDF/X-1a PLUS 
Commercial CMYK v1

Color or grayscale Minimum ❍ 100 dpi 100 dpi 150 dpi

Maximum ❍ 400 dpi 200 dpi 450 dpi
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❍ = not checked

Solution

If the effective resolution of an image is too low, you have the following options:

• Scan the original image at a higher resolution

• Check the resolution of the original image and make sure that the image has not been scaled up at a later 
stage, e.g. after it has been imported in a DTP program.

Black-and-white Minimum ❍ 600 dpi 600 dpi 600 dpi

Maximum ❍ 2000 dpi 1270 dpi 3600 dpi

Image type Resolution PDF/X-1a:2001 
v2

PDF/X-1a PLUS 
Magazines v2

PDF/X-1a PLUS 
Newspapers v2

PDF/X-1a PLUS 
Commercial CMYK v1
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• Check the downsampling-related Job Options in 
Acrobat Distiller. Choose Settings > Job Options and 
display the Compression tab. Make sure the downsam-
pling is not selected or that the values to which images 
have to be downsampled are higher than the required 
minimum values.

Changed image resolution

Meaning

A black-and-white or color image had a higher resolution than the value allowed. The resolution of an image 
is the amount of information or detail it contains, expressed in dots per inch (dpi). High-resolution images 
contain a lot of information and result in large file sizes. That is why the profile checks the image resolution in 
your documents. If the profile finds images of which the resolution exceeds the maximum values, it will down-
sample them. If downsampling is done by the PDF/X profile, the bicubic downsampling method will be used.
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The following maximum values are applied for color and black-and-white images:

Image type Resolution PDF/X-1a:
2001 v2

PDF/X-1a PLUS 
Magazines v2

PDF/X-1a PLUS 
Newspapers v2

PDF/X-1a PLUS 
Commercial CMYK v1

Color or grayscale Maximum allowed ❍ 400 dpi 200 dpi 450 dpi

Image is down-
sampled to 

❍ 300 dpi 150 dpi 300 dpi

Black-and-white Maximum allowed ❍ 2000 dpi 1270 dpi 3600 dpi

Image is down-
sampled to 

❍ 1200 dpi 800 dpi ❍

❍ = not checked or downsampled
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Errors and Cautions of the Category “Image Compression”

Image compression changed

Meaning

Depending on the type of images you are dealing with, different compression methods are recommended. Using 
the appropriate compression methods can significantly reduce the file size of the PDF document. That is why the 
profile checks which compression method is used in your PDF document. It checks the compression methods used 
for color or grayscale images on the one hand and for black-and-white images on the other. If the profile detects 
an inappropriate compression method, it will automatically change it and apply the following methods:

• ZIP compression for color or grayscale images

• CCITT compression for black-and-white images
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Errors and Cautions of the Category “OPI”

Removed OPI

Cause

An object contains OPI information. As the PDF file must have created with images with a higher resolution, the 
OPI is not of any use anymore. Moreover, the OPI information is superfluous and can cause some problems. With 
PageMaker, for example, it can be impossible to work with images containing OPI information. Even if you have 
used a higher resolution, the OPI information can still be associated to the image.

Solution

Use images without OPI information or delete the OPI information from the file. You can proceed in two ways:

• Click to clear the “Preserve OPI Comments” setting in Acrobat Distiller. You will find this setting on the 
Advanced tab of the Job Options.

• Select an image containing OPI information with the Select Object  tool of Enfocus PitStop Professional. Click 
Windows and Show PitStop Inspector. Click the Prepress and OPI tabs, and the Remove Information button.

Tip: An action list enables you to quickly find all the objects containing OPI information. Select Window and 
Show PitStop Action List Panel. Click the Managing tab and New. Click Add and, in the dialog box (New Action 
Type) that appears, click Gather OPI information on the Informs tab, Add, Close and OK. On the Executing tab, 
select Complete document and Create report and click Execute. The action list is executed and a report is 
displayed with hyperlinks to images containing OPI information in the PDF.
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Errors and Cautions of the Category “Annotations”

Removed annotation

Meaning

The PDF document contains one or more annotations of either one of the following types:

• Hyperlink

• Movie and sound

• Trapping

• Printer marks

• File attachment

• Custom

Annotations of these types can cause problems in a work environment. For more information on the different 
types of annotation, see Acrobat Help (Help > Acrobat Help).

The offending annotation has automatically been removed by the PDF/X-1a profile.
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Annotation setting changed to non-printing

Meaning

Annotations made in a PDF document can be set to print or not to print. One or more annotations set to print 
were found in the checked PDF document. This is not recommended in a work environment.

The annotation setting is changed and set not to print (non-printing).
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Errors and Cautions of the Category “Metadata”

Removed form fields, thumbnails, bookmarks, article threads or unused destinations

Cause

The document contains the following types of metadata:

• Form fields

• Thumbnails: a minimized reproduction of the pages in your PDF document. Thumbnails can be a useful tool 
for visual navigation or to change the page arrangement in the PDF document (you only have to drag the thumb-
nails to rearrange the pages). Adobe Acrobat 5 automatically creates the thumbnails again when you open the 
Thumbnails Palette (Window > Thumbnails). 

• Bookmarks: the titles and subtitles of your document in a separate list. Bookmarks are also a very useful tool 
for navigation: you only have to click on a title in order to find the required part or chapter.

• Article threads: a sort of “thread” in your PDF document that follows the development of your document when 
you read it on screen. Article threads are useful when the text is made up of several columns, with text flowing 
across pages.

• Unused destinations: links to another PDF document. Using destinations allows you to create a linked collec-
tion of documents. Unused destinations contain no specific link to another file.
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All metadata are very useful, and sometimes necessary, to make a document readable on screen, but the can 
increase the size of a file considerably. They are moreover not necessary for PDF documents set to print. If the 
PDF/X-1a profile finds metadata in the document, an error message appears in the report.

Solution

The PDF/X-1a profile automatically removes all the metadata from the PDF document.

Document contains actions

Cause

Certain special effects can be added to PDF documents, in the form of actions that are executed when a book-
mark, link or form field is clicked, or when a specific page is viewed.

Typical examples of this kind of actions:

• Jumping to a specific page.

• Playing a sound or movie clip.

• Execute a Javascript function

The PDF/X standard does not allow a PDF document to contain any actions.
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Solution

Remove all actions from the PDF document. Do one of the following:

• Suppress the exporting of links and actions in your source application.

• If you have Enfocus PitStop Professional, create an Action List with the following commands: either “Remove 
all annotations” or “Remove annotations of type X” (e.g. links, Javascript), and “Remove actions”.

• Use the Adobe Acrobat tools to remove each individual action.

Removed actions

Meaning

The PDF/X standard does not allow actions in a PDF document. Actions can include:

• Custom Javascript functions

• Standard actions that are executed when a link or bookmark is selected, such as jumping to a specific location 
in the document, playing a movie or sound clip, etc.

The PDF/X Profile has automatically removed the actions from the PDF document.
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Errors and Cautions of the Category “PDF/X”

Removed embedded PostScript fragment

Meaning

The document contains embedded PostScript fragments. Embedded PostScript fragments are PostScript instruc-
tions for printing that could cause problems. The PDF/X-1a profile has automatically removed these embedded 
PostScript fragments. This check allows you to find all fragments of embedded PostScript in the PDF document. 
Embedded PostScript fragments may change the appearance of the printed document but do not show up in the 
screen preview.

Page description contains inline PS code

Meaning

See “Removed embedded PostScript fragment” on page 222.
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Trapnet annotation does not conform to PDF/X-1a requirements

Cause

In printing, even the slightest misregistration of the plates can cause gaps or color shifts between colored objects 
to appear. Trapping is a technique that compensates for misregistration by expanding adjacent colored objects 
so that they overlap. Trapping can be performed either before PDF creation, by the source application, or during 
the RIP-process.

If the traps in a document were added before the PDF document was created, they are included in the PDF file 
as trap networks. A page may have more than one trap network, e.g. one for each intended output device, but 
all the different trap networks are stored in the same trap network (trapnet) annotation. When printed, the 
trapnet annotation provides all the required trapping information for the page.

When trapnet annotations are found in the document, PDF/X-1a requires that:

• Trapping occurs only when all the fonts in the document are embedded.

• The CMYK color space is used.

Solution

When you create new PDF files, make sure that you embed all the used fonts. You can do this as follows in Acrobat 
Distiller:

1 Choose Settings > Job Options.

2 Click the Fonts tab.

3 Select Embed All Fonts and add all the required fonts in the Always Embed list.
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Also, check your source documents for occurrences of color spaces other than CMYK, and convert them to CMYK. 
If you have Enfocus PitStop Professional or another PDF/X solution, it is easier to change this in the PDF document. 
Proceed as follows:

1 Click the cross sign (✗ ) in the report.

The Enfocus PitStop Navigator Panel appears and the first object not in the CMYK color space is visible.

2 Choose Window > Show PitStop Inspector and check the color values.

3 Choose Window > Show PitStop Global Change.

4 In the Object tab > Color, in the “From” area, click Grab Fill.

Tip: Also check the color management settings in Enfocus PitStop Professional. For more information, read the 
following chapters in the Enfocus PitStop Professional User Guide:

• "Setting Your Enfocus PitStop Professional Preferences"

and

• "Chapter 11: Color Management"

5 In the “To” area, select the color you want to which you want to convert the offending color. You can do this 
in several ways:

• Click Load and load a color from the repository.

• In the PDF document, click an object that has the right color and then click Grab Fill in the Global Change 
panel.

• Specify the CMYK colors and click Save in order to reuse this color later on.

6 Click Apply.
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7 Select Apply to > Complete Document and click Apply to carry on this change in the entire PDF document. If 
you still have other PDF documents containing this specific color, click Save as Action List.

PDF/X version key set to PDF/X-1a:2001

Meaning

The PDF/X version key identifies which version of the PDF/X standard is followed by the document. If the version 
key is not set correctly, the document may not be eligible for further processing.

The PDF/X version key has been set to PDF/X-1a:2001.

Annotation lies inside printable area

Cause

The PDF/X standard does not allow annotations inside the bleed box (or, if no bleed box has been defined, the 
trim box). Annotations are not allowed in the printable area of a document, because they may cause differences 
between the printed output and the on-screen representation.
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Solution

Remove the annotations from the PDF document. You can do this in Adobe Acrobat by selecting 
Tools > Comments > Delete All.

Moved objects outside of printable area

Meaning

The PDF/X standard does not allow annotations inside the bleed box (or, if no bleed box has been defined, the 
trim box). Annotations are not allowed in the printable area of a document, because they may cause differences 
between the printed output and the on-screen representation.

The PDF/X Profile has automatically moved the offending annotations outside of the bleed box (or, if no bleed 
box has been defined in the document, outside of the trim box).
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Errors and Cautions of the Category “PDF/X Color”

Changed Output Intent

Meaning

In PDF/X a PDF document must contain the intended output intent. The output intent identifies what the final 
output destination of the document is, enabling everybody involved in the workflow to take the output intent 
into account. For example, a color proof may take into account the type of paper on which the document will be 
printed. 

This check verifies that the output intent is present and valid according to PDF/X rules, and if necessary, sets the 
output intention in a PDF document, either to a standard ICC characterization name or to a CMYK ICC profile.
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